Notice

The company reserves the right to revise this publication or to change its contents without notice. Information contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse) of this publication.

This publication and any accompanying software may not, in whole or in part, be reproduced, translated, transmitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators of this publication, except for copies kept by the user for backup purposes.

Brand and product names mentioned in this publication may or may not be copyrights and/or registered trademarks of their respective companies. They are mentioned for identification purposes only and are not intended as an endorsement of that product or its manufacturer.

©December 2009

Trademarks

Intel and Intel Core are trademarks/registered trademarks of Intel Corporation.
Preface

FCC Statement
(Federal Communications Commission)
You are cautioned that changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Re orient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:

1. This device may not cause interference.
   And
2. This device must accept any interference, including interference that may cause undesired operation of the device.
FCC RF Radiation Exposure Statement:

1. This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

2. This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator and your body.

Warning
Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not expressly approved by the manufacturer for compliance with the above standards could void your authority to operate the equipment.

EuP Off Mode Power Consumption Statement:
The figures below note the power consumption of this computer in compliance with European Commission (EC) regulations on power consumption in off mode:

- Off Mode < 1W
IMPORTANT SAFETY INSTRUCTIONS

Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet basement or near a swimming pool.
2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There may be a remote risk of electrical shock from lightning.
3. Do not use the telephone to report a gas leak in the vicinity of the leak.
4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may explode. Check with local codes for possible special disposal instructions.
5. This product is intended to be supplied by a Listed Power Unit (Full Range AC/DC Adapter - AC Input 100 - 240V, 50 - 60Hz DC Output 19V, 11.57A (220W) minimum).

This Computer’s Optical Device is a Laser Class 1 Product
Instructions for Care and Operation

The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1. **Don’t drop it, or expose it to shock.** If the computer falls, the case and the components could be damaged.

   - Do not expose the computer to any shock or vibration.
   - Do not place it on an unstable surface.
   - Do not place anything heavy on the computer.

2. **Keep it dry, and don’t overheat it.** Keep the computer and power supply away from any kind of heating element. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly damaged.

   - Do not expose it to excessive heat or direct sunlight.
   - Do not leave it in a place where foreign matter or moisture may affect the system.
   - Don’t use or store the computer in a humid environment.
   - Do not place the computer on any surface that will block the Vents/Fan Intakes.
Preface

3. **Avoid interference.** Keep the computer away from high capacity transformers, electric motors, and other strong magnetic fields. These can hinder proper performance and damage your data.

4. **Follow the proper working procedures for the computer.** Shut the computer down properly and don’t forget to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

<table>
<thead>
<tr>
<th>Do not turn off the power until you properly shut down all programs.</th>
<th>Do not turn off any peripheral devices when the computer is on.</th>
<th>Do not disassemble the computer by yourself.</th>
<th>Perform routine maintenance on your computer.</th>
</tr>
</thead>
</table>

5. **Take care when using peripheral devices.**

| Use only approved brands of peripherals. | Unplug the power cord before attaching peripheral devices. |
Power Safety
The computer has specific power requirements:

- Only use a power adapter approved for use with this computer.
- Your AC/DC adapter may be designed for international travel but it still requires a steady, uninterrupted power supply. If you are unsure of your local power specifications, consult your service representative or local power company.
- The power adapter may have either a 2-prong or a 3-prong grounded plug. The third prong is an important safety feature; do not defeat its purpose. If you do not have access to a compatible outlet, have a qualified electrician install one.
- When you want to unplug the power cord, be sure to disconnect it by the plug head, not by its wire.
- Make sure the socket and any extension cord(s) you use can support the total current load of all the connected devices.
- Before cleaning the computer, make sure it is disconnected from any external power supplies (i.e. AC/DC adapter or car adapter).

Do not plug in the power cord if you are wet.

Do not use the power cord if it is broken.

Do not place heavy objects on the power cord.
Battery Precautions

- Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.
- Do not remove any batteries from the computer while it is powered on.
- Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly result in fire.
- If you do not use the battery for an extended period, then remove the battery from the computer for storage.
- Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.
- Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qualified service personnel.
- Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries may explode or leak if exposed to fire, or improperly handled or discarded.
- Keep the battery away from metal appliances.
- Affix tape to the battery contacts before disposing of the battery.
- Do not touch the battery contacts with your hands or metal objects.

---

Battery Disposal & Caution

The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life, under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the manufacturer. Discard used battery according to the manufacturer’s instructions.
Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the power supply. Then refer servicing to qualified service personnel under any of the following conditions:

- When the power cord or AC/DC adapter is damaged or frayed.
- If the computer has been exposed to rain or other liquids.
- If the computer does not work normally when you follow the operating instructions.
- If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
- If there is an unusual odor, heat or smoke coming from your computer.

Removal Warning
When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and screw(s) before turning the computer on.
Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:

1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Close the display panel and make sure it's latched.
4. Disconnect the AC/DC adapter and cables. Stow them in the carrying bag.
5. The AC/DC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter. However, check with your travel agent to see if you need any socket adapters.
6. Put the notebook in its carrying bag and secure it with the bag’s straps.
7. If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters and/or cables.
8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hardware and software. Make sure your “papers” are handy.

Power Off Before Traveling
Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a notebook which is powered on in a travel bag may cause the Vents/Fan Intakes to be blocked. To prevent your computer from overheating make sure nothing blocks the Vent/Fan Intakes while the computer is in use.
On the Road

In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting, keep these points in mind:

**Hand-carry the notebook** - For security, don’t let it out of your sight. In some areas, computer theft is very common. Don’t check it with “normal” luggage. Baggage handlers may not be sufficiently careful. Avoid knocking the computer against hard objects.

**Beware of Electromagnetic fields** - Devices such as metal detectors & X-ray machines can damage the computer, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). **Note:** Some airports also scan luggage with these devices.

**Fly safely** - Most airlines have regulations about the use of computers and other electronic devices in flight. These restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

**Get power where you can** - If an electrical outlet is available, use the AC/DC adapter and keep your battery(ies) charged.

**Keep it dry** - If you move quickly from a cold to a warm location, water vapor can condense inside the computer. Wait a few minutes before turning it on so that any moisture can evaporate.
Preface

Developing Good Work Habits
Developing good work habits is important if you need to work in front of the computer for long periods of time. Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or other joints. The following are some tips to reduce the strain:

- Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the level of your elbow. Keep your forearms, wrists, and hands in a relaxed position.
- Your knees should be slightly higher than your hips. Place your feet flat on the floor or on a footrest if necessary.
- Use a chair with a back and adjust it to support your lower back comfortably.
- Sit straight so that your knees, hips and elbows form approximately 90-degree angles when you are working.
- Take periodic breaks if you are using the computer for long periods of time.

Remember to:
- Alter your posture frequently.
- Stretch and exercise your body several times a day.
- Take periodic breaks when you work at the computer for long periods of time. Frequent and short breaks are better than fewer and longer breaks.
Lighting

Proper lighting and a comfortable viewing angle can reduce eye strain and shoulder and neck muscle fatigue.

- Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
- Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
- Position the display directly in front of you at a comfortable viewing distance.
- Adjust the display-viewing angle to find the best position.

LCD Screen Care

To prevent image persistence on LCD monitors (caused by the continuous display of graphics on the screen for an extended period of time) take the following precautions:

- Set the Windows Power Plans to turn the screen off after a few minutes of screen idle time.
- Use a rotating, moving or blank screen saver (this prevents an image from being displayed too long).
- Rotate desktop background images every few days.
- Turn the monitor off when the system is not in use.

Cable TV Safety

If you have included a TV Tuner in your purchase option then pay careful attention to the following:

- Make sure that your CATV system installer has connected the Coaxial cable shield to the grounding system of the building, as close to the point of cable entry as practical.
- This reminder is provided to call the CATV system installer’s attention to Article 820-93 of the NEC (Section 54, Part I of the Canadian Electrical Code).
- The TV antenna supplied with any TV Tuner module is intended for indoor use only. Please do not use your TV Tuner module outdoors.
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notice</td>
<td>I</td>
</tr>
<tr>
<td>FCC Statement</td>
<td>II</td>
</tr>
<tr>
<td>FCC RF Radiation Exposure Statement</td>
<td>III</td>
</tr>
<tr>
<td>EuP Off Mode Power Consumption Statement</td>
<td>III</td>
</tr>
<tr>
<td>Instructions for Care and Operation</td>
<td>V</td>
</tr>
<tr>
<td>Power Safety</td>
<td>VII</td>
</tr>
<tr>
<td>Battery Precautions</td>
<td>VIII</td>
</tr>
<tr>
<td>Cleaning</td>
<td>IX</td>
</tr>
<tr>
<td>Servicing</td>
<td>IX</td>
</tr>
<tr>
<td>Travel Considerations</td>
<td>X</td>
</tr>
<tr>
<td>Quick Start Guide</td>
<td></td>
</tr>
<tr>
<td>Overview</td>
<td>1-1</td>
</tr>
<tr>
<td>Advanced Users</td>
<td>1-2</td>
</tr>
<tr>
<td>Beginners and Not-So-Advanced Users</td>
<td>1-2</td>
</tr>
<tr>
<td>Warning Boxes</td>
<td>1-2</td>
</tr>
<tr>
<td>Not Included</td>
<td>1-3</td>
</tr>
<tr>
<td>System Software</td>
<td>1-4</td>
</tr>
<tr>
<td>RAID &amp; AHCI Setup</td>
<td>1-4</td>
</tr>
<tr>
<td>System Startup</td>
<td>1-5</td>
</tr>
<tr>
<td>System Map: LCD Panel Open &amp; Top View</td>
<td>1-6</td>
</tr>
<tr>
<td>LED Indicators</td>
<td>1-7</td>
</tr>
<tr>
<td>Game Keys</td>
<td>1-7</td>
</tr>
<tr>
<td>Touch Sensor Instant Keys</td>
<td>1-8</td>
</tr>
<tr>
<td>Keyboard</td>
<td>1-9</td>
</tr>
<tr>
<td>Function Keys &amp; Visual Indicators</td>
<td>1-10</td>
</tr>
<tr>
<td>System Map: Front &amp; Rear Views</td>
<td>1-11</td>
</tr>
<tr>
<td>System Map: Right View</td>
<td>1-12</td>
</tr>
<tr>
<td>System Map: Left View</td>
<td>1-13</td>
</tr>
<tr>
<td>System Map: Bottom View</td>
<td>1-15</td>
</tr>
<tr>
<td>Video Features</td>
<td>1-17</td>
</tr>
<tr>
<td>Screen Resolution</td>
<td>1-18</td>
</tr>
<tr>
<td>Power Options</td>
<td>1-20</td>
</tr>
<tr>
<td>Storage Devices, Mouse, Audio &amp; Printer</td>
<td></td>
</tr>
<tr>
<td>Overview</td>
<td>2-1</td>
</tr>
<tr>
<td>Hard Disk Drive</td>
<td>2-2</td>
</tr>
<tr>
<td>Optical Device</td>
<td>2-3</td>
</tr>
<tr>
<td>Loading Discs</td>
<td>2-3</td>
</tr>
<tr>
<td>Handling CDs or DVDs</td>
<td>2-4</td>
</tr>
<tr>
<td>DVD Regional Codes</td>
<td>2-5</td>
</tr>
<tr>
<td>7-in-1 Card Reader</td>
<td>2-6</td>
</tr>
<tr>
<td>ExpressCard Slot</td>
<td>2-7</td>
</tr>
<tr>
<td>Game Keys</td>
<td>2-8</td>
</tr>
<tr>
<td>HDMI Ports</td>
<td>2-9</td>
</tr>
</tbody>
</table>
Preface

GameMate Media Player (HDMI-In) ........................................ 2-10
HDMI Audio Configuration .................................................. 2-13
Audio Setup for LCD Monitors/TVs with HDMI Input ...... 2-14
Audio Features .................................................................... 2-16
Suppressing Audio Background Noise .............................. 2-17
Setup for Audio Recording .................................................... 2-19
Setup for 5.1 Surround Sound ............................................. 2-20
Sound Effects Equalizer .................................................... 2-22
Dolby Settings ..................................................................... 2-23
TouchPad and Buttons/Mouse ............................................. 2-24
Gestures and Device Settings ............................................. 2-25
Adding a Printer ................................................................. 2-28
USB Printer ......................................................................... 2-28
Install Instructions: ............................................................. 2-28
Parallel Printer ................................................................. 2-28

Power Management

Overview ............................................................................. 3-1
The Power Sources ........................................................... 3-2
AC/DC Adapter .................................................................. 3-2
Battery ............................................................................... 3-2
Turning On the Computer .................................................. 3-3
Power Plans ......................................................................... 3-4
Power-Saving States .......................................................... 3-6
Sleep .................................................................................. 3-6
Hibernate ............................................................................ 3-7
Shut down ........................................................................... 3-7
Configuring the Power Buttons ......................................... 3-8
Resuming Operation ........................................................... 3-9
Battery Information ........................................................... 3-10
Conserving Battery Power .................................................. 3-11
Battery Life ......................................................................... 3-12
New Battery ......................................................................... 3-12
Recharging the Battery with the AC/DC Adapter ......... 3-12
Proper handling of the Battery Pack ................................. 3-13
Battery FAQ ......................................................................... 3-14

Drivers & Utilities

RAID & AHCI Setup ............................................................ 4-1
What to Install ..................................................................... 4-1
Module Driver Installation .................................................. 4-1
Driver Installation ............................................................... 4-2
Manual Driver Installation .................................................. 4-3
Updating/Reinstalling Individual Drivers .......................... 4-4
User Account Control (Win Vista) ...................................... 4-4
Windows Security Message ............................................... 4-4
New Hardware Found ....................................................... 4-4
Driver Installation Procedure ............................................ 4-5
Video .................................................................................. 4-5
Audio ................................................................. 4-5
LAN ........................................................................... 4-5
TouchPad ................................................................. 4-6
Card Reader/ExpressCard ........................................... 4-6
GameKey Utility ......................................................... 4-6
Hot Key ....................................................................... 4-6
HDMI-In Driver ......................................................... 4-6
Optional Drivers .......................................................... 4-7
Wireless LAN ............................................................. 4-8
PC Camera ................................................................. 4-8
Consumer Infrared (for TV Tuner Remote) ......................... 4-8
Fingerprint Reader Module ........................................... 4-8

BIOS Utilities
Overview ................................................................. 5-1
The Power-On Self Test (POST) .................................... 5-2
Failing the POST .......................................................... 5-3
Fatal Errors ................................................................. 5-3
Non-Fatal Errors ........................................................... 5-4
The Setup Utility .......................................................... 5-4
Entering Setup ............................................................... 5-4
Setup Screens ............................................................... 5-5
Main Menu ................................................................. 5-6
System Time & Date (Main Menu) ..................................... 5-6
System/Extended Memory: (Main Menu) ......................... 5-7

BIOS Revision/VGA Card etc. (Main Menu) ......................... 5-7
Advanced Menu .......................................................... 5-8
SATA Mode (Advanced Menu) ....................................... 5-8
Legacy USB Support: (Advanced Menu) ......................... 5-9
Boot-time Diagnostic Screen: (Advanced Menu) ............... 5-9
Power On Boot Beep (Advanced Menu) ......................... 5-9
Battery Low Alarm Beep: (Advanced Menu) ..................... 5-9
Security Menu ............................................................. 5-10
Set Supervisor Password (Security Menu) ......................... 5-10
Set User Password (Security Menu) ............................... 5-11
Password on boot (Security Menu) ................................. 5-11
Boot Menu ................................................................. 5-12
Exit Menu ................................................................. 5-13

Upgrading The Computer
Overview ................................................................. 6-1
When Not to Upgrade .................................................. 6-2
Removing the Battery ................................................... 6-3
Upgrading the Hard Disk Drive(s) .................................... 6-4
Upgrading the System Memory (RAM) - 1 ....................... 6-8
Upgrading the System Memory (RAM) - 2 ....................... 6-13
Upgrading the Optical (CD/DVD) Device ......................... 6-19
Upgrading the Video Card ............................................. 6-20
Preface

Modules
Overview .............................................................. 7-1
Setting Up SATA RAID Mode ............................. 7-2
Intel® Matrix Storage Manager ......................... 7-2
SATA RAID Setup Procedure (BIOS) .................... 7-4
RAID Setup (Intel Matrix) ................................. 7-5
Intel® Matrix Driver Installation ....................... 7-7
Intel® Matrix Storage Manager ......................... 7-8
RAID Volume Data Verification and Repair .......... 7-9
Replacing and Reverting Recovery and Master Volumes ....................................................... 7-9
Bluetooth Module ............................................. 7-11
Bluetooth Configuration in Windows 7 ............... 7-12
Wireless LAN Module ....................................... 7-16
Intel® Wi-Fi Link Series Driver Installation ........ 7-17
802.11b/g/n Driver Installation .......................... 7-17
Connecting to a Wireless Network in Windows 7 .... 7-18
Windows Mobility Center .................................. 7-21
PC Camera Module .......................................... 7-22
PC Camera Driver Installation ........................... 7-22
PC Camera Audio Setup ..................................... 7-23
TV Tuner Module ............................................. 7-29
Consumer Infrared Driver ................................ 7-30
Digital TV Broadcast Signal .............................. 7-31
TV Recording and Power Plans .......................... 7-31
Remote Control Unit ......................................... 7-31
Fingerprint Reader Module ............................... 7-32
Fingerprint Reader Driver Installation .............. 7-33
User Enrollment .............................................. 7-34
Fingerprint Control Center Features ................. 7-37

Troubleshooting
Overview .......................................................... 8-1
Basic Hints and Tips ........................................... 8-2
Backup and General Maintenance ................... 8-3
Viruses ............................................................. 8-4
Upgrading and Adding New Hardware/Software ... 8-5
Problems & Possible Solutions ......................... 8-7

Interface (Ports & Jacks)
Overview .......................................................... A-1
Ports and Jacks .................................................. A-2
Card Reader ...................................................... A-2
Cable (CATV) .................................................... A-2
Antenna Jack ...................................................... A-2
Consumer Infrared Transceiver ......................... A-2
DC-In Jack ......................................................... A-2
DVI-Out Port ...................................................... A-2
e-SATA/USB Port .............................................. A-3
HDMI-Out Port .................................................. A-3
HDMI-IN Port ........................................................ A-3
Headphone-Out Jack ................................................. A-3
Line-In Jack ............................................................... A-3
Microphone-In Jack .................................................. A-4
Mini-IEEE 1394 Port ................................................ A-4
RJ-45 LAN Jack ......................................................... A-4
S/PDIF-Out Jack ....................................................... A-4
Security Lock Slot .................................................. A-4
USB 2.0/1.1 Ports ..................................................... A-5

NVIDIA Video Driver Controls
NVIDIA Video Driver Installation ................................ B-1
NVIDIA Control Panel (Win 7) ................................. B-2
Display Devices ...................................................... B-5
Display Modes ........................................................ B-6
Attaching Other Displays (Win 7) ......................... B-11
SLI Multi GPU Configuration .............................. B-14
SLI Multi GPU Configuration & Battery Power .... B-15
Enabling TV Display ........................................... B-16

Specifications
Processor ................................................................. C-2
Core Logic ............................................................... C-2
Display ................................................................. C-2
Memory ................................................................. C-2
Video Adapter Options ............................................. C-2
BIOS ........................................................................ C-2
Storage ................................................................. C-2
Audio ....................................................................... C-2
Keyboard & Pointing Device ................................. C-3
Card Reader ........................................................... C-3
Slots ....................................................................... C-3
Interface ................................................................ C-3
Communication ..................................................... C-3
Security ................................................................ C-3
Operating System .................................................. C-4
Power Management ................................................ C-4
Power ..................................................................... C-4
Environmental Spec ............................................... C-4
Physical Dimensions & Weight ............................. C-4
Chapter 1: Quick Start Guide

Overview

This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the computer and to getting your system started. The remainder of the manual covers the following:

• Chapter 2 A guide to using some of the main features of the computer e.g. the storage devices (hard disk, optical device, 7-in-1 card reader, ExpressCard/34), Game Keys, HDMI Ports, TouchPad & Mouse, Audio Features & Printer.

• Chapter 3 The computer’s power management options.

• Chapter 4 The installation of the drivers and utilities essential to the operation or improvement of some of the computer’s subsystems.

• Chapter 5 An outline of the computer’s built-in software or BIOS (Basic Input Output System).

• Chapter 6 Instructions for upgrading your computer.

• Chapter 7 A quick guide to the computer’s RAID, Bluetooth, Wireless LAN, PC Camera, TV Tuner and Fingerprint modules (some of which may be optional depending on your purchase configuration).

• Chapter 8 A troubleshooting guide.

• Appendix A Definitions of the interface, ports/jacks which allow your computer to communicate with external devices.

• Appendix B Information on the NVIDIA Video driver controls.

• Appendix C The computer’s specification.
Advanced Users

If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful to refer to “Drivers & Utilities” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “Upgrading The Computer” on page 6 - 1 in the User’s Manual. You may also find the notes marked with a of interest to you.

Beginners and Not-So-Advanced Users

If you are new to computers (or do not have an advanced knowledge of them) then the information contained in this Quick Start Guide should be enough to get you up and running. Eventually you should try to look through all the documentation (more detailed descriptions of the functions, setup and system controls are covered in the remainder of the User’s Manual), but do not worry if you do not understand everything the first time. Keep this manual nearby and refer to it to learn as you go. You may find it useful to refer to the notes marked with a as indicated in the margin. For a more detailed description of any of the interface ports and jacks see “Interface (Ports & Jacks)” on page A - 1.

Warning Boxes

No matter what your level please pay careful attention to the warning and safety information indicated by the symbol. Also please note the safety and handling instructions as indicated in the Preface.
Not Included
Operating Systems (e.g. \textit{Windows 7}) and applications (e.g. word processing, spreadsheet and database programs) have their own manuals, so please consult the appropriate manuals.

\begin{itemize}
  \item \textbf{Drivers}
  
  If you are installing new system software, or are re-configuring your computer for a different system, you will need to install the appropriate drivers. Drivers are programs which act as an interface between the computer and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order listed in \textit{Table 4 - 1, on page 4 - 3}. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If your system hasn’t been properly configured (your service representative may have already done that for you), refer to \textit{“Drivers & Utilities” on page 4 - 1} for installation instructions.

  \item \textbf{Ports and Jacks}
  
  See \textit{“Ports and Jacks” on page A - 2} for a description of the interface (ports & jacks) which allow your computer to communicate with external devices, connect to the internet etc.
\end{itemize}
System Software
Your computer may already come with system software pre-installed. Where this is not the case, or where you are re-configuring your computer for a different system, you will find the *Windows 7* operating system is supported.

*Note:* In order to run *Windows 7* without limitations or decreased performance, your computer requires a minimum **1GB** of system memory (RAM).

RAID & AHCI Setup
Note that setting up a RAID, or AHCI mode, needs to be done prior to installing the *Windows OS* (see “Setting Up SATA RAID Mode” on page 7 - 2).
System Startup

1. Remove all packing materials, and place the computer on a stable surface.
2. Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.
3. Attach the AC/DC adapter to the DC-In jack at the rear of the computer, then plug the AC power cord into an outlet, and connect the AC power cord to the AC/DC adapter.
4. Use one hand to raise the lid/LCD to a comfortable viewing angle (it is preferable not to exceed 130 degrees); use the other hand (as illustrated in Figure 1 - 1 below) to support the base of the computer (Note: Never lift the computer by the lid/LCD).
5. Raise the lid/LCD to a comfortable viewing angle, and press the power button.

Shutdown

Note that you should always shut your computer down by choosing the Shut Down command from the Start menu in Windows 7. This will help prevent hard disk or system problems.

Figure 1 - 1 - Computer with AC/DC Adapter Plugged-In/Opening the Lid/LCD
**Quick Start Guide**

**Figure 1 - 2**  
System Map: LCD Panel Open & Top View

1. Optional Built-In PC Camera
2. LCD
3. LED Status Indicators
4. Touch Sensor Instant Keys
5. 8 * Gaming Keys
6. Keyboard
7. TouchPad and Buttons
8. Fingerprint Reader Module (optional)
9. LED Power Indicators
10. LCD Panel Color LED

See *Appendix A* for a more detailed description of the ports & jacks etc.

### Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices (e.g. WLAN or Bluetooth) aboard aircraft is usually prohibited. Make sure any wireless modules are OFF if you are using the computer aboard aircraft.

Use the appropriate function key combination/Touch Sensor Key to toggle power to any wireless modules, and check the indicators to see if any modules are powered on or not (see *Table 1 - 2*, on page *1 - 8*).
LED Indicators
The two sets of LED indicators (LED Status Indicators and LED Power Indicators) display helpful information about the current status of the computer.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Hard Disk Activity" /></td>
<td>Blinking Blue</td>
<td>Hard Disk Activity</td>
</tr>
<tr>
<td><img src="image" alt="Number Lock" /></td>
<td>Blue</td>
<td>Number Lock is Activated</td>
</tr>
<tr>
<td><img src="image" alt="Caps Lock" /></td>
<td>Blue</td>
<td>Caps Lock is Activated</td>
</tr>
<tr>
<td><img src="image" alt="Scroll Lock" /></td>
<td>Blue</td>
<td>Scroll Lock is Activated</td>
</tr>
<tr>
<td><img src="image" alt="Computer On/Off" /></td>
<td>Green</td>
<td>The Computer is On</td>
</tr>
<tr>
<td><img src="image" alt="Computer Sleep Mode" /></td>
<td>Blinking Green</td>
<td>The Computer is In Sleep Mode</td>
</tr>
<tr>
<td><img src="image" alt="Battery Charging" /></td>
<td>Orange</td>
<td>The Battery is Charging</td>
</tr>
<tr>
<td><img src="image" alt="Battery Low Power" /></td>
<td>Blinking Orange</td>
<td>The Battery has Reached</td>
</tr>
<tr>
<td><img src="image" alt="Battery Fully Charged" /></td>
<td>Green</td>
<td>Critically Low Power Status</td>
</tr>
</tbody>
</table>

Table 1 - 1 - LED Status Indicators

Game Keys
The eight Game Keys on the left of the computer allow macros to be configured for common keystrokes used in applications, as long as the driver is installed.
Quick Start Guide

Touch Sensor Instant Keys

Press the Touch Sensor Instant Keys on the computer to toggle the appropriate function on/off. When a module is powered on, the appropriate icon will be highlighted.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="icon" alt="LED Color Toggle" /></td>
<td>LED Color Toggle (press to toggle flashing colors or single color)</td>
<td><img src="icon" alt="Wireless LAN Module Power Toggle" /></td>
<td>Wireless LAN Module Power Toggle</td>
</tr>
<tr>
<td><img src="icon" alt="PC Camera Module Power Toggle" /></td>
<td>PC Camera Module Power Toggle</td>
<td><img src="icon" alt="Activate the Default Internet Browser" /></td>
<td>Activate the Default Internet Browser</td>
</tr>
<tr>
<td><img src="icon" alt="Bluetooth Module Power Toggle" /></td>
<td>Bluetooth Module Power Toggle</td>
<td><img src="icon" alt="Sound Effects Equalizer Mode Toggle" /></td>
<td>Sound Effects Equalizer Mode Toggle (see page 2 - 22)</td>
</tr>
<tr>
<td><img src="icon" alt="Toggle *Silent Mode (for power saving) Visual Indicator" /></td>
<td>Toggle *Silent Mode (for power saving) Visual Indicator</td>
<td><img src="icon" alt="Mute Toggle" /></td>
<td>Mute Toggle</td>
</tr>
<tr>
<td><img src="icon" alt="Volume Control Slider" /></td>
<td>Volume Control Slider (move your finger slowly along the slider to adjust the system volume)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Table 1 - 2 - Touch Sensor Instant Keys*

*When enabled, Silent Mode will reduce fan noise and save power consumption. Note this may reduce computer performance.*
Keyboard

The keyboard has an embedded numerical keypad for easy numeric data input, and features function keys to allow you to change operational features instantly. See Table 1 - 3, on page 1 - 10 for full function key combination details.

Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will detect and enable it automatically. However special functions/hot-keys unique to the system’s regular keyboard may not work.

Num Lk & Scr Lk

Hold down the Fn Key and Scr Lk/Num Lk to enable scroll lock/number lock, and check the LED indicator for status.

Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters. These special characters can only be produced by using the numeric keypad. Regular number keys (in the upper row of the keyboard) will not work. Make sure that NumLk is on.
Quick Start Guide

Function Keys & Visual Indicators

The **function keys** (F1 - F12 etc.) will act as **hot keys** when pressed while the **Fn** key is held down. In addition to the basic function key combinations; visual indicators (see the table below) are available when the Hot Key driver is installed (see “Hot Key” on page 4 - 6). After installing the driver an icon will appear in the taskbar.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function/Visual Indicators</th>
<th>Keys</th>
<th>Function/Visual Indicators</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fn + ~</td>
<td>Play/Pause (in Audio/Video Programs)</td>
<td>Fn + F8/F9</td>
<td>Brightness Decrease/Increase</td>
</tr>
<tr>
<td>Fn + F1</td>
<td>Touchpad Toggle</td>
<td>Fn + F10</td>
<td>PC Camera Power Toggle</td>
</tr>
<tr>
<td>Fn + F2</td>
<td>Turn LCD Backlight Off (Press a key to or use Touchpad to turn on)</td>
<td>Fn + F11</td>
<td>WLAN Module Power Toggle</td>
</tr>
<tr>
<td>Fn + F3</td>
<td>Mute Toggle</td>
<td>Fn + F12</td>
<td>Bluetooth Module Power Toggle</td>
</tr>
<tr>
<td>Fn + F4</td>
<td>Sleep Toggle</td>
<td>Fn + NumLk</td>
<td>Number Lock Toggle</td>
</tr>
<tr>
<td>Fn + F5/F6</td>
<td>Volume Decrease/Increase</td>
<td>Fn + ScrLk</td>
<td>Scroll Lock Toggle</td>
</tr>
<tr>
<td>Fn + F7</td>
<td>Display Toggle</td>
<td></td>
<td>Note: DO NOT use the <strong>Fn + F7</strong> key combination to toggle through display options when SLI is enabled (see “SLI Multi GPU Configuration” on page B - 14).</td>
</tr>
</tbody>
</table>

*Table 1 - 3 - Function Keys & Visual Indicators*
System Map: Front & Rear Views

Figure 1 - 5
Front View

1. Color LEDs
2. Speakers
3. LED Power Indicators
4. Consumer Infrared Transceiver (enabled with optional TV Tuner only)
5. DC-In Jack

TV Tuner Module Support

Note that the TV Tuner module (factory) option is supported by the Windows Media Center software. Windows Media Center is not included in Starter or Home Basic versions of Windows 7.

See Appendix A for a more detailed description of the ports & jacks etc.
Quick Start Guide

1. Headphone-In Jack
2. Microphone-In Jack
3. Line-In Jack
4. S/PDIF-Out Jack
5. Cable (CATV) Antenna Jack*
6. Combined eSATA/USB Port
7. USB 2.0 Port
8. Security Lock Slot
9. Power Button

*Enabled with Optional Mini-PCI TV Tuner Only

See Appendix A for a more detailed description of the ports & jacks etc.

System Map: Right View

TV Tuner Module Support

Note that the TV Tuner module (factory) option is supported by the Windows Media Center software. Windows Media Center is not included in Starter or Home Basic versions of Windows 7.

USB Ports

Note that the connections to the USB ports only fit one way, do not force them.
System Map: Left View

1. DVI-Out Port
2. 2 * USB 2.0 Ports
3. RJ-45 LAN Jack
4. HDMI-Out Port
5. 7-in-1 Card Reader
6. ExpressCard 34 Slot
7. HDMI-In Port
8. Mini-IEEE 1394 Port
9. Optical Device Drive Bay

Mini-IEEE 1394 Port
The Mini-IEEE 1394 port only supports SELF POWERED IEEE 1394 devices.

7-in-1 Card Reader
The card reader allows you to use the most popular digital storage card formats:
- MMC (MultiMedia Card) / SD (Secure Digital) / MS (Memory Stick)
- MS Pro (Memory Stick Pro) / MS Duo (requires PC adapter)
- Mini SD (requires PC adapter) / RS MMC (requires PC adapter)

HDMI Ports
Note that the HDMI Ports support video and audio signals to attached external displays (also see "HDMI Ports" on page 2 - 9).

USB Ports
Note that the connections to the USB ports only fit one way, do not force them.

See Appendix A for a more detailed description of the ports & jacks etc.
Quick Start Guide

Disk Eject Warning
Don’t try to eject a CD/DVD while the system is accessing it. This may cause the system to "crash". Stop the disk first then eject it, or press the stop button twice.

CD/DVD Emergency Eject
If you need to manually eject a CD/DVD (e.g. due to an unexpected power interruption) you may push the end of a straightened paper clip into the emergency eject hole. Do not use a sharpened pencil or any object that may break and become lodged in the hole. Don’t try to remove a floppy disk/CD/DVD while the system is accessing it. This may cause the system to "crash".

Changing DVD Regional Codes
Go to the Control Panel and double-click Device Manager (Hardware and Sound), then click the + next to DVD/CD-ROM drives. Double-click on the DVD-ROM device to bring up the Properties dialog box, and select the DVD Region (tab) to bring up the control panel to allow you to adjust the regional code.

DVD region detection is device dependent, not OS-dependent. You can select your module’s region code 5 times. The fifth selection is permanent. This cannot be altered even if you change your operating system or you use the module in another computer.
System Map: Bottom View

1. Sub Woofer
2. Fan Outlet/Intake
3. Component Bay Cover
4. Battery (Secondary HDD Bay - HDD3)
5. Primary HDD Bay (HDD1 & 2)

See Appendix A for a more detailed description of the ports & jacks etc.

Overheating
To prevent your computer from overheating make sure nothing blocks the vent(s)/fan intake(s) while the computer is in use.

Battery Information
Always completely discharge, then fully charge, a new battery before using it. Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges. See “Battery Information” on page 3-10 for full instructions.
Windows 7 Start Menu & Control Panel

Most of the control panels, utilities and programs within Windows 7 (and most other Windows versions) are accessed from the Start menu. When you install programs and utilities they will be installed on your hard disk drive, and a shortcut will usually be placed in the Start menu and/or the desktop. Right-click the Start menu icon, and then select Properties if you want to customize the appearance of the Start menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features in Windows (e.g. power, video, network, audio etc.). Windows 7 provides basic controls for many of the features, however many new controls are added (or existing ones are enhanced) when you install the drivers. To see all controls it may be necessary to toggle off Category View to view the control panel icons.
Video Features

You can configure display options, from the Display Settings control panel in Windows as long as the appropriate video driver is installed. For more detailed video information see “NVIDIA Video Driver Controls” on page B - 1.

To access Display (Control Panel) and Screen Resolution in Windows:
1. Click Start and click Control Panel.
2. Click Display (icon) - In theAppearances and Personalization category.
3. Click Adjust Screen Resolution/Adjust resolution.
OR
4. Alternatively you can right-click the desktop and select Screen resolution (see right).
5. Use the dropbox to select the screen Resolution 1 (Figure 1 - 10 on page 1 - 18).
6. Click Advanced settings 2 (Figure 1 - 10 on page 1 - 18) to bring up the Advanced properties tabs.

To access the NVIDIA Control Panel:
1. Click Start, and click Control Panel.
2. Click NVIDIA Control Panel 3 (Figure 1 - 11 on page 1 - 19) - In the Appearances and Personalization category.
OR
3. Click Start and click All Programs > NVIDIA Corporation.
4. Click to select NVIDIA Physx Properties 4 (Figure 1 - 11 on page 1 - 19).
OR
5. Click Advanced settings in the Screen Resolution control panel in Windows.
6. Click GeForce....(tab) and click Start the NVIDIA Control Panel 5 (Figure 1 - 11 on page 1 - 19).
Quick Start Guide

Screen Resolution

Video Options
Note that card types, specifications and drivers are subject to continual updates and changes. Check with your service center for the latest details on video cards supported.

Figure 1 - 10 - Screen Resolution

1 - 18 Video Features
NVIDIA Control Panel

Figure 1 - NVIDIA Control Panel
Power Options

The Power Options (Hardware and Sound menu) control panel icon in Windows (see page 1 - 16) allows you to configure power management features for your computer. You can conserve power by means of power plans and configure the options for the power button, sleep button, computer lid (when closed), display and sleep mode from the left menu. Note that the Power saver plan may have an affect on computer performance.

Click to select one of the existing plans, or click Create a power plan in the left menu and select the options to create a new plan. Click Change plan settings and click Change advanced power settings to access further configuration options.

Pay attention to the instructions on battery care in “Battery Information” on page 3 - 11.
Chapter 2: Storage Devices, Mouse, Audio & Printer

Overview
Read this chapter to learn more about the following main features and components of the computer:

• Hard Disk Drive
• Optical Device
• 7-in-1 Card Reader
• ExpressCard Slot
• Game Keys
• HDMI Ports
• Audio Features
• TouchPad and Buttons/Mouse
• Adding a Printer
Hard Disk Drive

The hard disk drive(s) is(are) used to store your data in the computer. The hard disk(s) can be taken out to accommodate other 2.5" serial (SATA) hard disk drives with a height of 9.5 mm. The primary hard disk bay 1 is accessible from the bottom of your computer as seen below, and the secondary hard disk bay 2 is located under the battery compartment.

The computer can accommodate up to three hard disks (two in the primary bay, and one in the secondary bay), and these may be configured in RAID or AHCI modes. Further details on removing and inserting the hard disk are available in “Upgrading the Hard Disk Drive(s)” on page 6 - 4.

Figure 2 - 1
Hard Disk Location
Optical Device

There is a bay for a 5.25" optical (CD/DVD) device (12.7mm height). The actual device will depend on the model you purchased (see “Storage” on page C - 2). The optical device is usually labeled “Drive D:" and may be used as a boot device if properly set in the BIOS (see “Boot Menu” on page 5 - 12).

Loading Discs

To insert a CD/DVD, press the open button 1 and carefully place a CD/DVD onto the disc tray with label-side facing up (use just enough force for the disc to click onto the tray’s spindle). Gently push the CD/DVD tray in until its lock “clicks” and you are ready to start. The busy indicator 2 will light up while data is being accessed, or while an audio/video CD, or DVD, is playing. If power is unexpectedly interrupted, insert an object such as a straightened paper clip into the emergency eject hole 3 to open the tray.

Figure 2 - 2
Optical Device

Sound Volume Adjustment

How high the sound volume can be set depends on the setting of the volume control within Windows. Click the Volume icon on the taskbar to check the setting.

Peripherals must be connected before you turn on the system.
Handling CDs or DVDs
Proper handling of your CDs/DVDs will prevent them from being damaged. Please follow the advice below to make sure that the data stored on your CDs/DVDs can be accessed.

Note the following:

- Hold the CD or DVD by the edges; do not touch the surface of the disc.
- Use a clean, soft, dry cloth to remove dust or fingerprints.
- Do not write on the surface with a pen.
- Do not attach paper or other materials to the surface of the disc.
- Do not store or place the CD or DVD in high-temperature areas.
- Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
- Do not bend the CD or DVD.
- Do not drop or subject the CD or DVD to shock.
DVD Regional Codes

To change the DVD regional codes see “Changing DVD Regional Codes” on page 1 - 14.

### DVD Regional Coding

<table>
<thead>
<tr>
<th>Region</th>
<th>Geographical Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>USA, Canada</td>
</tr>
<tr>
<td>2</td>
<td>Western Europe, Japan, South Africa, Middle East &amp; Egypt</td>
</tr>
<tr>
<td>3</td>
<td>South-East Asia, Taiwan, South Korea, The Philippines, Indonesia, Hong Kong</td>
</tr>
<tr>
<td>4</td>
<td>South &amp; Central America, Mexico, Australia, New Zealand</td>
</tr>
<tr>
<td>5</td>
<td>N Korea, Russia, Eastern Europe, India &amp; Most of Africa</td>
</tr>
<tr>
<td>6</td>
<td>China</td>
</tr>
</tbody>
</table>

Table 2 - 1

*DVD Regional Coding*
7-in-1 Card Reader

The card reader allows you to use some of the latest digital storage cards. Push the card into the slot and it will appear as a removable device, and can be accessed in the same way as your hard disk(s). Make sure you install the Card Reader driver (see “Card Reader/ExpressCard” on page 4 - 6).

- MMC (MultiMedia Card)
- SD (Secure Digital)
- MS (Memory Stick)
- MS (Memory Stick Pro)
- MS Duo (requires PC adapter*)
- Mini SD (requires PC adapter*)
- RS MMC (requires PC adapter*)

*Note: The PC adapters are usually supplied with these cards.
ExpressCard Slot

The computer is equipped with an **ExpressCard/34** slot that reads Express Card/34 and ExpressCard/54 formats. ExpressCards are the successors to PCMCIA (PC Cards). Make sure you install the ExpressCard driver (see “Card Reader/Express-Card” on page 4 - 6).

Inserting and Removing ExpressCards

- Align the ExpressCard with the slot and push it in until it locks into place (as pictured in the *generic* figure below).
- To remove an ExpressCard, simply press the card to eject it.

![ExpressCard Slot](image)

Make sure you keep the cover in the Express-Card slot when not in use. This will help prevent foreign objects and/or dust getting in to the ExpressCard Slot.

*Figure 2 - 4 ExpressCard Slot*

1. Express Card Slot
Game Keys

The eight game hot keys on the left of the computer allow macros to be configured for common keystrokes used in applications (the keys can assigned macros for any program, not only games). To configure the keys follow the instructions below (make sure you have installed the GameKey Utility driver - see “GameKey Utility” on page 4 - 6).

1. Run the **Game Key Configuration** program from the desktop icon (or from C:\Program Files\Chicony\GameKeys\GmKeyCfgUtl.exe).
2. Double-click the button for the appropriate key (it will turn red).
3. When the button is red you may then record the keystrokes to be assigned to the Game Key.
4. Click **OK**.
5. Repeat the procedure for the other Game Key if required.
6. Close the **Game Key Configuration** window.
7. The keystroke order will be repeated with the appropriate button press in any application program.
HDMI Ports

This computer features both HDMI (High-Definition Multimedia Interface) input and output ports. HDMI is a compact audio/video interface for transmitting uncompressed digital data.

- The HDMI-Out port allows you to display and hear video/audio sources from your computer to digital TVs, displays or audio systems that support an HDMI input.
- The HDMI-In port allows you to display external sources such as Blu-ray players, DVDs, set top boxes and games consoles etc. on your computer screen.

See “NVIDIA Video Driver Controls” from page B - 1 for information on setting up external displays connected to the HDMI-Out port.

Make sure you install the HDI-In driver in order to support any HDMI input sources (see “HDMI-In Driver” on page 4 - 6). When the HDMI-In driver is installed the GameMate Media Player will be installed.
Storage Devices, Mouse, Audio & Printer

GameMate Media Player (HDMI-In)
The GameMate Media Player allows you to play content from digital sources through the HDMI-In port.

1. Connect your digital source to the HDMI-In port using an HDMI cable.
2. Access the GameMate Media Player from the desktop shortcut or from GameMate folder in Program Files.
3. Press play on any attached digital source player (or use a remote control to navigate the menus of consoles etc.).
4. The picture will appear in the GameMate Media Player.

![GameMate Player](image)

*Figure 2-6*
GameMate Player
Double-click the GameMate screen to toggle through different screen size options. You can also right-click the screen to access the configuration menu to adjust any of the following settings:

**RENDERED QUALITY**
Select High, Medium or Low quality from this menu item.

![Rendered Quality Settings](image1.png)

**STANDARD**
Select NTSC or PAL standard from this item.

![Standard Settings](image2.png)

**FORMAT**
Select the screen format here (only supported resolutions will be shown).

![Format Settings](image3.png)
Storage Devices, Mouse, Audio & Printer

ASPECT
The Aspect item allows you to select standard or wide screen aspect ratios.

SNAPSHOT
Click either the BMP or JPG items to take a screen shot of the current GameMate screen (the file will be placed in the Pictures library folder in Windows).

TOPSHOT
If enabled then the GameMate screen will remain on top of other windows.
HDMI Audio Configuration
As HDMI (High-Definition Multimedia Interface) carries both audio and video signals you can configure the audio output as per the instructions below.

Audio Setup for HDMI
1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Sound (Hardware and Sound).
3. Click Playback (tab), and click to select Realtek Digital Output.
4. Click Set Default (button).
5. Click OK to close the Sound control panel.
6. Select Speakers as the default for standard audio sources.

![Sound Playback Options](image)
Audio Setup for LCD Monitors/TVs with HDMI Input

Some LCD monitors/TVs support HDMI input, but DO NOT have built-in digital audio decoders. Where this is the case, when playing DVDs in Windows Media Player/CyberLink Power DVD, a background noise can occur. If this situation does arise then please follow the instructions below.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Sound (Hardware and Sound).
4. Click Supported Formats (tab).
5. Click to disable (remove the check in the box) DTS Audio and Dolby Digital.
6. Click OK and close the control panels.
HDMI Notes

• Connect a device with HDMI support to the HDMI-Out port BEFORE attempting to play audio/video sources through the device.

• If you disconnect the HDMI cable the default audio playback device will not revert to speakers until the computer is restarted (if you do not wish to restart the computer then go to the Sound control panel and select Speakers as the default audio playback device).

HDMI Video Configuration

1. Connect an HDMI cable from the HDMI-Out port to your external display.
2. Configure your external display as per the instructions in “Configuring an External Display using the NVIDIA Control Panel” on page B - 7.
3. Set up your external display (TV or LCD) for HDMI input (see your display device manual).
4. You can now play video/audio sources through your external display.

Other Applications

If you are using a third party application to play DVDs etc. you will need to consult the application’s documentation to see the appropriate audio configuration (the application must support digital to analog translation).
Audio Features

You can configure the audio options on your computer from the **Sound** control panel in *Windows*, or from the **Realtek HD Audio Manager** icon in the taskbar/control panel (right-click the taskbar icon to bring up an audio menu). The volume may also be adjusted by means of the **Fn + F5/F6** key combination or by moving your finger slowly along the Touch Sensor volume control slider (see **Table 1 - 2, on page 1 - 8**).

See “**HDMI Audio Configuration**” on page 2 - 13 for a description of the audio configuration when connecting an HDMI supported display device.
Suppressing Audio Background Noise

A background noise may occur when audio power management is enabled, and the system resumes from power saving. To solve this problem you can disable Realtek HD Audio Manager Power Management.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel) and make sure you are in Classic View.
2. Click Realtek HD Audio Manager (or right-click the taskbar icon and select Sound Manager).
3. Click the Power Management icon.

![Realtek Audio Manager](image)
4. Make sure that **Power Management** is **disabled** (when disabled the icon will be black); when enabled the icon will be blue.

5. Click **OK** to save the setting and close the control panel.
Setup for Audio Recording

To record audio sources on your computer at optimum quality follow the instructions below:

1. Click **Start**, and click **Control Panel** (or point to **Settings** and click **Control Panel**) and make sure you are in **Classic View**.
2. Click **Realtek HD Audio Manager** (or right-click the taskbar icon and select **Sound Manager**).
3. Click **Microphone Effects** (tab) in **Microphone** (tab), and then click to select **Noise Suppression** (button), or adjust the **Recording Volume** level to around 60, to obtain the optimum recording quality.
4. Click **OK** to close the control panel and save the settings.

---

**Beam Forming**

If your stereo microphone supports Beam Forming (Directional Recording), then click the button to calibrate the stereo microphone before recording.

---

*Figure 2 - 12*  
Realtek Audio Manager - Recording Setup
Setup for 5.1 Surround Sound

To setup your system for 5.1 surround sound you will need to connect the audio cables to the Line-In and Microphone-In jacks.

1. Click **Start**, and click **Control Panel** (or point to **Settings** and click **Control Panel**) and make sure you are in **Classic View**.
2. Click **Realtek HD Audio Manager** (or right-click the taskbar icon and select **Sound Manager**).
3. Click **Speakers** (tab) and click **Speaker Configuration** (tab).
4. Select **5.1 Speaker** from the **Speaker Configuration** pull-down menu.

![Figure 2 - 13 Speaker Configuration](image)

**Auto Popup Dialog**

You should enable the auto popup dialog to automatically detect when a device has been plugged-in. If disabled, double-click **connector settings** and click the box to enable the auto popup detection of plugged-in devices.
5. Plug the front speaker cables into the Headphone-Out Jack.
6. Plug in the other cables (you may require an adapter to connect each cable to the appropriate jack e.g a stereo mini to dual RCA adapter) from your speakers as follows:
   - Line-In Jack = Rear Speaker Out
   - Microphone-In Jack = Center/Subwoofer Speaker Out
7. As you plug in each cable a dialog box will pop up (see “Auto Popup Dialog” on page 2 - 20).
8. Click to put a tick in the appropriate box according to the speaker plugged-in (e.g. Rear Speaker Out), and then click OK to save the setting.
9. Click OK to exit Realtek HD Audio Manager.

Figure 2 - 14
Connected Device
Auto Popup
Sound Effects Equalizer

Press the Sound Effects Equalizer Mode Toggle button to toggle through some of the equalizer options (an on-screen icon will appear to show the selected mode). A more comprehensive list of options is available from the Equalizer drop-down list.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel) and make sure you are in Classic View.
2. Click Realtek HD Audio Manager (or right-click the taskbar icon and select Sound Manager).
3. Click Digital Output (tab), click Sound Effects (tab) and then click to select an option in the Equalizer drop-box.
4. Click OK to close the control panel and save the settings.

Figure 2 - 15
Realtek Audio Manager - Recording Setup
Dolby Settings
You can adjust the Dolby settings from the Dolby tab in Speakers Properties.

1. Click **Start**, and click **Control Panel** (or point to **Settings** and click **Control Panel**).
2. Click **Sound** (Hardware and Sound).
3. Click **Playback** (tab).
4. Double-click **Speakers** (or select **Properties** from the right-click menu).
5. Click **Dolby** (tab)
6. Adjust the settings to your preferences and click OK.

Figure 2 - 16
Speakers Properties
Dolby Settings
Storage Devices, Mouse, Audio & Printer

2 TouchPad and Buttons/Mouse

The TouchPad is an alternative to the mouse; however, you can also add a mouse to your computer through one of the USB ports. The TouchPad buttons function in much the same way as a two-button mouse.

Once you have installed the TouchPad driver (see “TouchPad” on page 4 - 6) you can configure the functions from the Mouse control panel in Windows, or by double-clicking the TouchPad driver icon on the taskbar. You may then configure the TouchPad tapping, buttons, scrolling, pointer motion and sensitivity options to your preferences. You will find further information at www.synaptics.com.

Figure 2 - 17
Mouse Properties

Mouse Driver
If you are using an external mouse your operating system may be able to auto-configure your mouse during its installation or only enable its basic functions. Be sure to check the device’s user documentation for details.
The Synaptics Gestures Suite application allows you to use a specific gesture (action) on the surface of the TouchPad to perform specific actions to manipulate documents, objects and applications.

You can configure the settings from the Device Settings tab in **Mouse Properties**:
1. Click **Start**, and click **Control Panel** (or point to **Settings** and click **Control Panel**).
2. Click **Mouse** (**Hardware and Sound**).
3. Click **Device Settings** (tab) and click **Settings**.
4. Use the menu tree on the left to access the user configurable settings.

*Show Video*

You can get a clearer view of the gestures involved by clicking the **Show Video** option for each gesture item.

Select the gesture (**Pinch Zoom, Rotating, Three Fingers Down and Three Finger Flick**) in the **Device Settings > Settings** left tree menu and click the **Show Video** button to see the demonstration video.

For more details on any of the gestures see the help in the lower part of the right menu window.

*Figure 2 - 18*

**Mouse Properties - Device Settings**
Storage Devices, Mouse, Audio & Printer

2 - 26 TouchPad and Buttons/Mouse

Scrolling
The Two-Finger scrolling feature works in most scrollable windows and allows you to scroll horizontally and vertically. Place two fingers, slightly separated, on the TouchPad surface and slide both fingers in the direction required (in a straight continuous motion).

Figure 2 - 19
Scrolling Gesture

Zooming
The Pinch Zoom gesture can be used to perform the same function as a scroll wheel in Windows applications that support CTRL + scroll wheel zoom functionality. Place two fingers on the TouchPad (for best results use the tips of the fingers) and slide them apart to zoom in, or closer together to zoom out.

Figure 2 - 20
Zooming Gesture
Rotating
Use the Pivot Rotate gesture to rotate objects (e.g. photos) in 90 degree increments. Place a finger down on the left “target” zone and keep it stationary. Place another finger near the middle of the TouchPad and slide it in a circular motion around the stationary finger (clockwise or counterclockwise) to rotate the object.

Three Finger-Flick/Three Fingers Down (Press)
The Three Finger-Flick gesture may be used to enhance navigation with a variety of applications such as browsing the Internet or scrolling through a photo viewer. The Three Fingers Down gesture may be used to launch user-selectable applications.
Adding a Printer

The most commonly used peripheral is a printer. The following conventions will help you to add a printer; however it is always best to refer to the printer manual for specific instructions and configuration options.

**USB Printer**

Most new printers have a USB interface connection. You may use any one of the ports to connect the printer.

**Install Instructions:**
1. Set up the printer according to its instructions (unpacking, paper tray, toner/ink cartridge etc.).
2. Turn ON the computer.
3. Turn ON the printer.
4. Connect the printer's USB cable to one of the USB ports on the computer.
5. Windows will identify the printer and either load one of its own drivers or ask you to supply one. Follow the on-screen instructions.

**Parallel Printer**

This is still a very common type of printer. The install instructions are in the sidebar (you will need to purchase a parallel to USB converter).
Chapter 3: Power Management

Overview

To conserve power, especially when using the battery, your computer power management conserves power by controlling individual components of the computer (the monitor and hard disk drive) or the whole system.

This chapter covers:

- The Power Sources
- Turning On the Computer
- Power Plans
- Power-Saving States
- Configuring the Power Buttons
- Battery Information

The computer uses enhanced power saving techniques to give the operating system (OS) direct control over the power and thermal states of devices and processors. For example, this enables the OS to set devices into low-power states based on user settings and information from applications.

OS Note

Power management functions will vary slightly depending on your operating system. For more information it is best to refer to the user’s manual of your operating system.

(Note: All pictures used on the following pages are from the Windows 7 OS.)
The Power Sources

The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter

Use only the AC/DC adapter that comes with your computer. The wrong type of AC/DC adapter will damage the computer and its components (see page C - 4).

1. Attach the AC/DC adapter to the DC-In jack at the rear of the computer.
2. Plug the AC power cord into an outlet, and then connect the AC power cord to the AC/DC adapter.
3. Raise the lid/LCD to a comfortable viewing angle.
4. Press the power button to turn “On”.

Battery

The battery allows you to use your computer while you are on the road or when an electrical outlet is unavailable. Battery life varies depending on the applications and the configuration you're using. To increase battery life, let the battery discharge completely before recharging (see “How do I completely discharge the battery?” on page 3 - 14).

We recommend that you do not remove the battery. For more information on the battery, please refer to “Battery Information” on page 3 - 10.
Turning On the Computer

Now you are ready to begin using your computer. To turn it on simply press the power button on the front panel.

When the computer is on, you can use the power button as a Stand by/Hibernate/Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and holding the power button for longer than this will shut the computer down). Use Power Options in the Windows control panel to configure this feature.

Forced Off

If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, press the power button for 4 seconds, or longer, to force the system to turn itself off.

Power Button as Stand by or Hibernate Button

You can use the OS’s Power Options control panel to set the power button to send the system into Stand by or Hibernate mode (see your OS’s documentation, or “Configuring the Power Buttons” on page 3-8 for details).

Shut Down

Note that you should always shut your computer down by choosing the Shut Down command from the bottom right of the Start menu in Windows. This will help prevent hard disk or system problems.
Power Plans

The computer can be configured to conserve power by means of power plans. You can use (or modify) an existing power plan, or create a new one.

The settings may be adjusted to set the display to turn off after a specified time, and to send the computer into Sleep after a period of inactivity.

Click Change plan settings and then click Change advanced power settings to access further configuration options in Advanced Settings.

Figure 3 - 1
Power Plan Advanced Settings (Win 7)

Resuming Operation
See Table 3 - 1, on page 3 - 9 for information on how to resume from a power-saving state.

Password
It is recommended that you enable a password on system resume in order to protect your data.
Each *Windows power plan* will also adjust the processor performance of your machine in order to save power. This is worth bearing in mind if you are experiencing any reduced performance (especially under DC/battery power).

Choose **High performance** (you may need to click **Show additional plans** to view the High performance plan) for maximum performance when the computer is powered from an AC power source. Choose the **Power saver** (bear in mind that this scheme may slow down the overall performance of the computer in order to save power) for maximum power saving when the computer is battery (DC power) powered.
Power Management

Power-Saving States

You can use power-saving states to stop the computer’s operation and restart where you left off. Win 7 uses the Sleep, Hibernate and Shut Down power-saving states.

Sleep

In Sleep all of your work, settings and preferences are saved to memory before the system sleeps. When you are not using your computer for a certain length of time, which you specify in the operating system, it will enter Sleep to save power.

The PC wakes from Sleep within seconds and will return you to where you last left off (what was on your desktop) without reopening the application(s) and file(s) you last used.

If your mobile PC in Sleep is running on battery power the system will use only a minimum amount of power. After an extended period the system will save all the information to the hard disk and shut the computer down before the battery becomes depleted.

3 - 6 Power-Saving States
Hibernate

Hibernate uses the least amount of power of all the power-saving states and saves all of your information on a part of the hard disk before it turns the system off. If a power failure occurs the system can restore your work from the hard disk; if a power failure occurs when work is saved only to memory, then the work will be lost. Hibernate will also return you to where you last left off within seconds. You should put your mobile PC into Hibernate if you will not use the computer for a period of time, and will not have the chance to charge the battery.

Shut down

You should Shut down the computer if you plan to install new hardware (don’t forget to remove the battery and follow all the safety instructions in Chapter 6), plan to be away from the computer for several days, or you do not need it to wake up and run a scheduled task. Returning to full operation from Shut down takes longer than from Sleep or Hibernate.

Silent Mode

You can use Silent Mode to reduce power consumption and fan noise. Use the Silent Mode Touch Sensor Instant Key (isspace) to toggle this mode on/off.

On screen visual indicators (isspace) and the Touch Sensor Instant Key (isspace) will display the Silent Mode status (see Table 1 - 2, on page 1 - 8).

Note Silent Mode may reduce computer performance.
Power Management

Configuring the Power Buttons

The power/sleep button (Fn + F4 key combo) and closed lid may be set to send the computer in to a power-saving state. Click **Choose what the power buttons do** on the left menu in **Power Options** to bring up the menu.

Password Protection

It is recommended that you enable a password on wake up in order to protect your data.

However, you can disable this setting from the **Power Options** menu by clicking **Require a password on wake up** in the left menu, and selecting the options (click **Change settings that are currently unavailable**).

![Figure 3 - 4: Power Options Define Power Buttons](image)

3 - 8 Configuring the Power Buttons
Resuming Operation
You can resume operation from power-saving states by pressing the power button, or in some cases pressing the sleep button (Fn + F4 key combo).

<table>
<thead>
<tr>
<th>Power Status</th>
<th>Icon</th>
<th>Color</th>
<th>To Resume</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Off</td>
<td>Off</td>
<td></td>
<td>Press the Power Button</td>
</tr>
<tr>
<td>Sleep</td>
<td>Blinking Green</td>
<td></td>
<td>Press the Power Button</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Press the Sleep Button (Fn + F4 Key Combo)</td>
</tr>
<tr>
<td>Hibernate</td>
<td>Off (battery)</td>
<td>Orange (AC/DC adapter)</td>
<td>Press the Power Button</td>
</tr>
<tr>
<td>Display Turned Off</td>
<td>Green</td>
<td></td>
<td>Press a Key or Move the Mouse/Touchpad</td>
</tr>
</tbody>
</table>

Power Button
When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down hot key button when it is pressed for less than 4 seconds (pressing and holding the power button for longer than this will force the computer to shut down).

Closing the Lid
If you have chosen to send the computer to Sleep when the lid is closed, raising the lid will wake the system up.

Table 3 - 1
Resuming Operation
Battery Information

Follow these simple guidelines to get the best use out of your battery.

Battery Power

Your computer’s battery power is dependent upon many factors, including the programs you are running, and peripheral devices attached. You can set actions to be taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from power plan Change plan settings > Change advanced power settings (see Figure 3 - 1 on page 3 - 4).

Click the battery icon in the taskbar to see the current battery level and charge status.

Figure 3 - 5
Battery Icon (Taskbar) & Battery Advanced Settings
Conserving Battery Power

- Use a power plan that conserves power (e.g. Power saver), however note that this may have an affect on computer performance.

- Lower the brightness level of the LCD display. The system will decrease LCD brightness slightly to save power when it is not powered by the AC/DC adapter.

- Reduce the amount of time before the display is turned off.

- Close wireless, Bluetooth, modem or communication applications when they are not being used.

- Disconnect/remove any unnecessary external devices e.g. USB devices, ExpressCards etc.

![Windows Mobility Center](image)

*Figure 3 - 6 Windows Mobility Center

The Windows Mobility Center control panel provides an easy point of access for information on battery status, power plans used and wireless device status etc.*
Battery Life
Battery life may be shortened through improper maintenance. To optimize the life and improve its performance, fully discharge and recharge the battery at least once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to remove the battery for any reason (e.g. long term storage) see “Removing the Battery” on page 6 - 3.

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery FAQ” on page 3 - 14 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and plugged into an electrical outlet. If the computer is powered on, and in use, it will take several hours to fully recharge the battery. When the computer is turned off but plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indicators” on page 1 - 7 for information on the battery charge status, and to “Battery Information” on page 3 - 10 for more information on how to maintain and properly recharge the battery pack.)
**Proper handling of the Battery Pack**

- DO NOT disassemble the battery pack under any circumstances.
- DO NOT expose the battery to fire or high temperatures, it may explode.
- DO NOT connect the metal terminals (+, -) to each other.

---

**Damaged Battery Warning**

Should you notice any physical defects (e.g. the battery is bent out of shape after being dropped), or any unusual smells emanating from the notebook battery, shut your computer down immediately and contact your service center. If the battery has been dropped we do not recommend using it any further, as even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly result in fire. It is recommended that you replace your computer battery every two years.

---

**Caution**

Danger of explosion if battery is incorrectly replaced.

Replace only with the same or equivalent type recommended by the manufacturer. Discard used battery according to the manufacturer’s instructions.
Battery FAQ
How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t turn off the computer even if a message indicates the battery is critically low, just let the computer use up all of the battery power and shut down on its own.

1. Save and close all files and applications.
2. **Create a power plan** for discharging the battery and set all the options to **Never**.

*Figure 3 - 7*
Power Plan Create
3. Click **Change plan settings** (after creating it) and click **Change plan settings > Change advanced power settings**.

*Figure 3 - 8*

Change Plan Settings / Change Advanced Power Settings
4. Scroll down to **Battery** and click + to expand the battery options.

5. Choose the options below (click **Yes** if a warning appears):

- Low battery levels = 0%
- Critical battery Levels = 0%
- Low battery action = Do Nothing
- Critical battery action (On battery) = Shut Down
- Critical battery action (Plugged in) = Do Nothing

---

**Figure 3 - 9**

*Power Options Advanced Settings - Battery*
How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges.

**SLI Multi GPU Configuration & Battery Power**

Note that due to the high power and system demands created by enabling SLI Configuration, you should not enable SLI configuration if your computer is powered by battery only. If you attempt to run an SLI configuration when the computer is powered by the battery only, then system problems may occur.

If the computer is currently powered by battery only do not enable SLI configuration.

If you have currently enabled SLI configuration, and the computer is powered by the AC/DC adapter, do not switch to battery power only (or go to the NVIDIA Control Panel and disable SLI configuration before switching to battery power only).
Chapter 4: Drivers & Utilities

This chapter deals with installing the drivers and utilities essential to the operation or improvement of some of the computer’s subsystems. The system takes advantage of some newer hardware components for which the latest versions of most available operating systems haven’t built in drivers and utilities. Thus, some of the system components won’t be auto-configured with an appropriate driver or utility during operating system installation. Instead, you need to manually install some system-required drivers and utilities.

RAID & AHCI Setup

Note that setting up a RAID, or AHCI mode, needs to be done prior to installing the Windows OS, and therefore before installing the other drivers listed here (see “Setting Up SATA RAID or AHCI Modes” on page 7-36).

What to Install

The Device Drivers & Utilities + User’s Manual disc contains the drivers and utilities necessary for the proper operation of the computer.

Table 4-1, on page 4-3 lists what you need to install and it is very important that the drivers are installed in the order indicated.

Module Driver Installation

The procedures for installing drivers for the WLAN, PC Camera, Consumer Infrared (for TV tuner remote), and Fingerprint modules are provided in “Modules” on page 7-1.
Drivers & Utilities

Driver Installation

Insert the Device Drivers & Utilities + User’s Manual disc and click Install Drivers (button), or Option Drivers (button) to access the Optional driver menu.

1. Check the driver installation order from Table 4 - 1, on page 4 - 3 (the drivers must be installed in this order) which is the same as that listed in the Drivers Installer menu below.
2. Click to select the driver you wish to install, after installing each driver it will become grayed out. If you need to reinstall any driver, click the Unlock button (you should uninstall the driver first).
3. Follow the instructions for each individual driver installation procedure as listed on the following pages.

Figure 4 - 1 - Drivers Installer Screen 1

Figure 4 - 2 - Drivers Installer Screen 2
Manual Driver Installation

Click the **Browse CD/DVD** button in the **Drivers Installer** application and browse to the executable file in the appropriate driver folder.

**Windows Update**

After installing all the drivers make sure you enable **Windows Update** in order to get all the latest security updates etc. (all updates will include the latest **hotfixes** from Microsoft). See “**Windows Update**” on page 4 - 7 for instructions.

<table>
<thead>
<tr>
<th>Windows 7 Driver</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video</td>
<td>Page 4 - 5</td>
</tr>
<tr>
<td>Audio</td>
<td>Page 4 - 5</td>
</tr>
<tr>
<td>LAN</td>
<td>Page 4 - 5</td>
</tr>
<tr>
<td>TouchPad</td>
<td>Page 4 - 6</td>
</tr>
<tr>
<td>Card Reader/ExpressCard</td>
<td>Page 4 - 6</td>
</tr>
<tr>
<td>GameKey Utility</td>
<td>Page 4 - 6</td>
</tr>
<tr>
<td>Hot Key</td>
<td>Page 4 - 6</td>
</tr>
<tr>
<td>HDMI-In Driver</td>
<td>Page 4 - 6</td>
</tr>
<tr>
<td>Intel® Matrix Driver Installation (for RAID)</td>
<td>Page 7 - 7</td>
</tr>
<tr>
<td>Wireless LAN Module</td>
<td>Page 7 - 17</td>
</tr>
<tr>
<td>PC Camera Module</td>
<td>Page 7 - 22</td>
</tr>
<tr>
<td>TV Tuner Module</td>
<td>Page 7 - 30</td>
</tr>
<tr>
<td>Fingerprint Reader Module</td>
<td>Page 7 - 33</td>
</tr>
</tbody>
</table>

*Table 4 - 1 - Driver Installation*
Updating/Reinstalling Individual Drivers

If you wish to update/reinstall individual drivers it may be necessary to uninstall the original driver. To do this, go to the Control Panel in the Windows OS and double-click the Programs and Features icon (Programs > Uninstall a program). Click to select the driver (if it is not listed see below) and click Uninstall, and then follow the on screen prompts (it may be necessary to restart the computer). Reinstall the driver as outlined in this chapter.

If the driver is not listed in the Programs and Features menu:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click Device Manager (Hardware and Sound > Device Manager).
3. Double-click the device you wish to update/reinstall the driver for (you may need to click “+” to expand the selection).
4. Click Driver (tab) and click the Update Driver or Uninstall button and follow the on screen prompts.

User Account Control (Win Vista)

If a User Account Control prompt appears as part of the driver installation procedure, click Continue/Allow, and follow the installation procedure as directed.

Windows Security Message

If you receive a Windows security message as part of the driver installation process. Just click “Install this driver software anyway” or Install to continue the installation procedure.

You will receive this message in cases where the driver has been released after the version of Windows you are currently using. All the drivers provided will have already received certification for Windows.

New Hardware Found

If you see the message “New Hardware Found” during the installation procedure (other than when outlined in the driver install procedure), click Cancel to close the window, and follow the installation procedure.
Driver Installation Procedure

Insert the Device Drivers & Utilities + User’s Manual disc and click Install Drivers (button), or Option Drivers (button) to access the Optional driver menu.

Video
1. Click 1. Install Video Driver > Yes.
2. Click Next > Yes > Next.
3. Click Finish to restart the computer.

Audio
1. Click 2. Install Audio Driver > Yes.
2. Click Next.
3. Click Finish to restart the computer.

LAN
Make sure you have plugged the network cable in before installing the driver.

1. Click 3. Install LAN Driver > Yes.
2. Click Next > Install.
3. Click Finish to complete the installation.

RAID Note: Setting up a RAID, or AHCI mode, needs to be done prior to installing the Windows OS, and therefore before installing the other drivers listed here.
Drivers & Utilities

**TouchPad**
1. Click 4.Install Touchpad Driver > Yes.
2. Click Next.
3. Click the button to accept the license, and then click Next.
4. Click Finish > Restart Now to restart the computer.

**Card Reader/ExpressCard**
1. Click 5.Install Cardreader Driver > Yes.
2. Click Install > Finish.

If you receive the error message “0x000000D1” after installing the cardreader driver, see page 8 - 12 for details.

**GameKey Utility**
1. Click 6.Install GAMEkey Driver > Yes.
2. Click Next.
3. Click Finish to restart the computer.
4. See “Game Keys” on page 2 - 9 for information.

**Hot Key**
1. Click 7.Install Hotkey Driver > Yes.
2. Click Next > Next.
3. Click Finish > Finish to restart your computer.

You should install the HDMI-In driver if you intend to play and audio/video sources through the computer’s HDMI-In port.

**HDMI-In Driver**
1. Click Back (button) and then click Option Drivers (button).
2. Click 6.Install HDMI In Driver > Yes.
3. Click Next.
4. Click Finish (the application will prepare to install).
5. Click Next > Install.
6. Click Finish.
7. The GameMate application will appear on the desktop.
Optional Drivers

See the pages indicated for the driver installation procedures for any modules included in your purchase option.

Figure 4 - 3 - Optional Drivers Installer Screen

Windows Update

After installing all the drivers make sure you enable Windows Update in order to get all the latest security updates etc. (all updates will include the latest hotfixes from Microsoft).

To enable Windows Update make sure you are connected to the internet:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Check for updates (Security), or double-click Security Center and click Windows Update.
3. Double-click Check for updates (button).
4. The computer will now check for updates (you need to be connected to the internet).
5. Click Install now (button) to install the updates.
Drivers & Utilities

RAID Setup
Note: Prior to setting up the RAID you will need to use an operable computer to copy the RAID driver to a USB flash drive before installing the Windows Vista operating system. See “Setting Up SATA RAID Mode” on page 7 - 2 for configuration instructions.

Bluetooth Module
Note: The operating system is the default setting for Bluetooth control in Windows 7, and does not require a driver. See “Bluetooth Module” on page 7 - 11 for configuration instructions.

Wireless LAN
See the appropriate install procedure for your WLAN module in “Wireless LAN Module” on page 7 - 16.

PC Camera
See the install procedure in “PC Camera Module” on page 7 - 22.

Consumer Infrared (for TV Tuner Remote)
See the install procedure in “TV Tuner Module” on page 7 - 29.

Fingerprint Reader Module
See the install procedure in “Fingerprint Reader Module” on page 7 - 32.
Chapter 5: BIOS Utilities

Overview
This chapter gives a brief introduction to the computer’s built-in software:

Diagnostics: The POST (Power-On Self Test)

Configuration: The Setup utility
If your computer has never been set up, or you are making important changes to the system (e.g. hard disk setup), then you should review this chapter first and note the original settings found in Setup. Even if you are a beginner, keep a record of the settings you find and any changes you make. This information could be useful if your system ever needs servicing.

There is one general rule: Don’t make any changes unless you are sure of what you are doing. Many of the settings are required by the system, and changing them could cause it to become unstable or worse. If you have any doubts, consult your service representative.
The Power-On Self Test (POST)

If you enable the **Boot-time Diagnostic Screen** in the Setup Utility, each time you turn on the computer the system takes a few seconds to conduct a **POST**, including a quick test of the on-board RAM (memory).

As the **POST** proceeds, the computer will tell you if there is anything wrong. If there is a problem that prevents the system from booting, it will display a system summary and prompt you to run **Setup**.

If there are no problems, the **Setup** prompt will disappear and the system will load the operating system. Once that starts, you can’t get into **Setup** without rebooting.

---

**POST Screen**

1. BIOS information
2. CPU type
3. Memory status
4. Enter **Setup** prompt appears only during POST

**Note:** The **POST** screen as pictured right is for guideline purposes only. The **POST** screen on your computer may appear slightly different. If the **Boot-time Diagnostic Screen** is disabled (see page 5 - 9 as per the default setting), the POST screen will not appear.

---

*Figure 5 - 1 POST Screen*
Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and “non-fatal”.

Fatal Errors
These stop the boot process and usually indicate there is something seriously wrong with your system. Take the computer to your service representative or authorized service center as soon as possible.

Non-Fatal Errors
This kind of error still allows you to boot. You will get a message identifying the problem (make a note of this message!) followed by the prompt:

- Press <F1> to resume
- <F2> to enter Setup

Press F1 to see if the boot process can continue. It may work, without the correct configuration.

Press F2 to run the Setup program and try to correct the problem. If you still get an error message after you change the setting, or if the “cure” seems even worse, call for help.
The Setup Utility

The **Phoenix Setup** utility tells the system how to configure itself and manage basic features and subsystems (e.g. port configuration).

**Entering Setup**

To enter **Setup**, turn on the computer and press **F2** during the **POST**. The prompt (**Press F2 to Enter Setup**) seen in **Figure 5 - 1** on page **5 - 2** is usually present for a few seconds after you turn on the system. If you get a “Keyboard Error”, (usually because you pressed **F2** too quickly) just press **F2** again.

If the computer is already on, reboot using the **Ctrl + Alt + Delete** combination and then hold down **F2** when prompted. The **Setup** main menu will appear.
Setup Screens
The following pages contain additional advice on portions of the Setup.

Along the top of the screen is a menu bar with menu headings. When you select a heading, a new screen appears. Scroll through the features listed on each screen to make changes to Setup.

Instructions on how to navigate each screen are in the box along the bottom of the screen. If these tools are confusing, press F1 to call up a General Help screen, and then use the arrow keys to scroll up or down the page.

The Item Specific Help on the right side of each screen explains the highlighted item and has useful messages about its options.

If you see an arrow ► next to an item, press Enter to go to a sub-menu on that subject. The sub-menu screen that appears has a similar layout, but the Enter key may execute a command.
**Main Menu**

**System Time & Date (Main Menu)**
The hour setting uses the 24-hour system (i.e., ØØ = midnight; 13 = 1 pm). If you can change the date and time settings in your operating system, you will also change these settings. Some applications may also alter data files to reflect these changes.
System/Extended Memory: (Main Menu)
This item contains information on the system memory, and is not user configurable.
The system will auto detect the amount of memory installed.

BIOS Revision/VGA Card etc. (Main Menu)
This item contains information on the BIOS version and video card etc., and is not user configurable.
If you have installed the Windows 7 operating system with either AHCI or RAID mode enabled, DO NOT disable the set mode (if you wish to disable the set mode you will need to reinstall the Windows 7 OS).

*SATA Mode (Advanced Menu)*

You may enable/disable SATA RAID or AHCI mode for your hard disks, however you should only enable/disable SATA RAID or AHCI BEFORE installing an operating system, and after you have backed up all necessary files and data (see sidebar).
Legacy USB Support: (Advanced Menu)
Choose “Enabled” if you intend to use USB devices in systems which do not normally support USB functionality (e.g. DOS). The default setting is “Enabled” and does not need to be changed if you intend to use your USB devices in Windows.

Boot-time Diagnostic Screen: (Advanced Menu)
Use this menu item to enable/disable the Boot-time Diagnostic Screen. Enable this item to display the POST screen (see “The Power-On Self Test (POST)” on page 5 - 2).

Power On Boot Beep (Advanced Menu)
Use this menu item to enable/disable the beep as the computer starts up.

Battery Low Alarm Beep: (Advanced Menu)
Use this menu item to enable/disable the battery low alarm beep.
Security Menu

**Set Supervisor Password (Security Menu)**
You can set a password for access to the Phoenix SecureCore Setup Utility. This will not affect access to the computer OS (only the Phoenix SecureCore Setup Utility).
Set User Password (Security Menu)
You can set a password for user mode access to the Phoenix SecureCore Setup Utility. This will not affect access to the computer OS, (only the Setup utility) unless you choose to set a Password on Boot (see below). Many menu items in the Phoenix SecureCore Setup Utility cannot be modified in user mode. You can only set the user password after you have set the supervisor password.

Password on boot (Security Menu)
Specify whether or not a password should be entered to boot the computer (you may only set a password on boot if a supervisor password is enabled). If “Enabled” is selected, only users who enter a correct password can boot the system (see the warning in the sidebar). The default setting is “Disabled”.

Note: To clear existing passwords press Enter and type the existing password, then press Enter for the new password (without typing any password entry) and Enter again to confirm the password clearance.

Password Warning
If you set a boot password (Password on boot is “Enabled”), NEVER forget your password.

The consequences of this could be serious. If you cannot remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.
When you turn the computer on it will look for an operating system (e.g. Windows 7) from the devices listed in this menu, and in this priority order. If it cannot find the operating system on that device, it will try to load it from the next device in the order specified in the Boot priority order. Item specific help on the right is available to help you move devices up and down the order.
Choosing to **Discard Changes**, or **Exit Discarding Changes**, will wipe out any changes you have made to the **Setup**. You can also choose to restore the original **Setup** defaults that will return the **Setup** to its original state, and erase any previous changes you have made in a previous session.
Chapter 6: Upgrading The Computer

Overview

This chapter contains information on upgrading the computer. Follow the steps outlined to make the desired upgrades. If you have any trouble or problems you can contact your service representative for further help. Before you begin you will need:

- A small crosshead or Phillips screwdriver
- A small regular slotted (flathead) screwdriver
- An antistatic wrist strap

Before working with the internal components you will need to wear an antistatic wrist strap to ground yourself because static electricity may damage the components.

The chapter includes:

- Removing the Battery
- Upgrading the Hard Disk Drive(s)
- Upgrading the System Memory (RAM) - 1
- Upgrading the System Memory (RAM) - 2
- Upgrading the Optical (CD/DVD) Device

Please make sure that you review each procedure before you perform it.

Warranty Warning

Please check with your service representative before undertaking any upgrade procedures to find out if this will VOID your warranty.
When Not to Upgrade
These procedures involve opening the system’s case, adding and sometimes replacing parts. You should not perform any of these upgrades if:

- Your system is still under warranty or a service contract
- You don’t have all the necessary equipment
- You’re not in the correct environment
- You doubt your abilities

Under any of these conditions, contact your service representative to purchase or replace the component(s).

Upgrading the Processor
If you want to upgrade your computer by replacing the existing processor with a faster/new one you will need to contact your customer service representative. We recommend that you do not do this yourself, since if it is done incorrectly you may damage the processor or mainboard.

Power Safety Warning
Before you undertake any upgrade procedures, make sure that you have turned off the power, and disconnected all peripherals and cables (including telephone lines). It is advisable to also remove your battery in order to prevent accidentally turning the machine on.

Removal Warning
When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and screw(s) before turning the computer on.
Removing the Battery

If you are confident in undertaking upgrade procedures yourself, for safety reasons it is best to remove the battery.

1. Turn the computer off and turn it over.
2. Loosen screws 1 - 3 and carefully lift the battery 4 up.
3. Remove the battery from the battery bay.

**Warranty Warning**

Please check with your service representative before undertaking any upgrade procedures to find out if this will VOID your warranty.

*Figure 6 - 1
Battery Removal*
Upgrading the Hard Disk Drive(s)

The hard disk drive(s) can be taken out to accommodate other 2.5" serial (SATA) hard disk drives with a height of 9.5mm (h) (see “Storage” on page C - 2). Follow your operating system’s installation instructions, and install all necessary drivers and utilities (as outlined in “Drivers & Utilities” on page 4 - 1), when setting up a new hard disk.

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the hard disk bay cover and remove screws 1 & 2.

---

**HDD System Warning**
New HDD’s are blank. Before you begin make sure:
- You have backed up any data you want to keep from your old HDD.
- You have all the CD-ROMs and FDDs required to install your operating system and programs.
- If you have access to the internet, download the latest application and hardware driver updates for the operating system you plan to install. Copy these to a removable medium.
3. Remove the hard disk bay cover 3.
4. Remove screws 4 - 9 from the hard disk assembly.
5. Remove the hard disk assembly by pulling the tab to disconnect it from the connector 10.

Figure 6 - 3
Bay Cover Removal & Hard Disk Assembly Screws
Upgrading The Computer

6. Remove screws 11 - 20 (depending on how many hard disks you have installed in the assembly).
7. Separate the hard disk board 21 from the case 22.
8. Separate the hard disk(s) 23 & 24 from the case.
9. Reverse the process to install any new hard disk(s).

Figure 6 - 4
Hard Disk(s) Removal

6 - 6 Upgrading the Hard Disk Drive(s)
Removing the Hard Disk in the Secondary HDD Bay

1. Turn off the computer, and turn it over and remove the battery.
2. The secondary hard disk bay is located under the battery compartment.
4. Slide the hard disk assembly in the direction of the arrow 29.
5. Lift the hard disk assembly 30 out of the compartment.
6. Remove the screws 31 - 34 to release the hard disk from the case 35.
7. Reverse the process to install any new hard disk(s).
Upgrading the System Memory (RAM) - 1

The computer has two memory sockets for 204 pin Small Outline Dual In-line (SO-DIMM) DDR III (DDR3) type memory modules (see “Memory” on page C - 2). The total memory size is automatically detected by the POST routine once you turn on your computer.

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the component bay cover and remove screws 1 - 5.

Figure 6 - 6
Component Bay Cover Screws
3. Carefully (a fan and cable are attached to the underside of the cover) lift up the bay cover.
4. Carefully disconnect the fan cable 6, and remove the cover 7.

5. Loosen the heat sink screws in the order indicated 8 - 11.
Upgrading the System Memory (RAM)

6. Carefully (it may be hot) remove the heat sink.

7. Gently pull the two release latches on the sides of the memory socket in the direction indicated below.

8. The RAM module will pop-up, and you can remove it.

Contact Warning
Be careful not to touch the metal pins on the module’s connecting edge. Even the cleanest hands have oils which can attract particles, and degrade the module’s performance.
9. Pull the latches to release the second module if necessary.
10. Insert a new module holding it at about a 30° angle and fit the connectors firmly into the memory socket.
11. The module’s pin alignment will allow it to only fit one way. Make sure the module is seated as far into the socket as it will go. DO NOT FORCE the module; it should fit without much pressure.
12. Press the module in and down towards the mainboard until the socket levers click into place to secure the module.
13. Replace the heat sink (make sure you tighten the screws in the order indicated on the label as below).

Figure 6 - 11
Heat Sink Insertion
14. Replace the component bay cover and make sure you reconnect the fan cable (see Figure 6 - 7 on page 6 - 9).
15. Replace all the component bay cover screws.
16. Restart the computer to allow the BIOS to register the new memory configuration as it starts up.
Upgrading the System Memory (RAM) - 2

The computer has two memory sockets for 204 pin Small Outline Dual In-line (SO-DIMM) DDR III (DDR3) type memory modules (see “Memory” on page C - 2). The total memory size is automatically detected by the POST routine once you turn on your computer.

1. Turn off the computer, and turn it over and remove the battery.
2. Remove screws 1 & 2 from the bottom of the computer.

Figure 6 - 12
Bottom LED Cover Module Screws
Upgrading The Computer

3. Turn the computer over, open the Lid/LCD, and carefully (a cable is connected to the underside of the LED cover module) unsnap up the LED cover module from point 3 on the right.

Figure 6 - 13
LED Cover Module Removal

4. Lift up the LED cover module 4 and disconnect cable 5.

Figure 6 - 14
LED Cover Module Cable Disconnect

6 - 14 Upgrading the System Memory (RAM) - 2
5. Remove screws 6 - 10 from the keyboard.

6. Carefully lift the keyboard up, being careful not to bend the keyboard ribbon cable.
7. Disconnect the keyboard ribbon cable 11 from the locking collar socket 12.

Figure 6 - 15
Keyboard Screws

Figure 6 - 16
Disconnect the Keyboard Locking Collar
8. Remove the keyboard 13.

**Figure 6 - 17**
Keyboard Removal

9. Remove screws 14 - 17 from the keyboard shielding plate 18.

**Figure 6 - 18**
Keyboard Shielding Plate Removal
Upgrading The Computer

10. Gently pull the two release latches (19 & 20) on the sides of the memory socket in the direction indicated below.
11. The RAM module 21 will pop-up, and you can remove it.
12. Pull the latches to release the second module if necessary.
13. Insert a new module holding it at about a 30° angle and fit the connectors firmly into the memory socket.
14. The module’s pin alignment will allow it to only fit one way. Make sure the module is seated as far into the socket as it will go. DO NOT FORCE the module; it should fit without much pressure.
15. Press the module in and down towards the mainboard until the socket levers click into place to secure the module.
16. Replace the screws, shielding plate and keyboard (make sure you reconnect the keyboard cable).

Figure 6 - 19
RAM Module Removal

Contact Warning
Be careful not to touch the metal pins on the module’s connecting edge. Even the cleanest hands have oils which can attract particles, and degrade the module’s performance.

LED Module Cable
Make sure you reconnect the LED Module cable (5) (see Figure 6 - 14).
Upgrading The Computer

17. Snap the LED cover module down at the top of the module at points 22 & 23.
18. Push the LED cover module down on the left side at point 24, and then slide the module to the right (as illustrated) and snap down to secure it in place.

19. Replace the screws on the bottom of the computer (see Figure 6 - 12).
20. Restart the computer to allow the BIOS to register the new memory configuration as it starts up.

Figure 6 - 20
LED Cover Module
Slide to the Right & Snap Down
Upgrading the Optical (CD/DVD) Device

1. Locate the hard disk bay cover and remove screws 1 & 2.
2. Remove the hard disk bay cover 3.
3. Remove the screw at point 4, and use a screwdriver to carefully push out the optical device at point 5.
4. Reverse the process to install any new optical device.

Figure 6 - 21
Removing the CD/DVD Device
Upgrading The Computer

Upgrading the Video Card

If you intend to upgrade or add another VGA card follow the procedures outlined here. However please check with your service representative first to make sure your computer can support more than one video card, and that you are not going to void your warranty. Pay careful attention to the alignment of any video card into the slot on the mainboard.

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the component bay cover and remove screws 1 - 5.
3. Carefully (a fan and cable are attached to the under side of the cover) lift up the bay cover.
4. Carefully disconnect the fan cable 6, and remove the cover 7.

Warranty Warning
Please check with your service representative before undertaking any upgrade procedures to find out if this will VOID your warranty.

Figure 6 - 22
Component Bay Cover Screws & Cover Removal

Fan Cable
Make sure you reconnect the fan cable 6 before screwing down the bay cover.
5. Remove screws 8 - 10 (two video cards are pictured here) from the video card fan(s) and disconnect the fan cable(s) 11 (if two cards are present).
6. Remove the RAM fan(s) 12.

Caution
The heat sink, and video card area in general, contains parts which are subject to high temperatures. Allow the area time to cool before removing these parts.

Figure 6 - 23
Video Card Fan Screws

Figure 6 - 24
Video Card Fan Removal
7. Remove screws 13 - 16 from the heatsink in the order indicated on the label (two video cards are pictured here).
8. Grip the handle 17 and carefully remove the heatsink 18.
9. Remove screws 19 - 20 from the video card.

Caution
The heat sink, and video card area in general, contains parts which are subject to high temperatures. Allow the area time to cool before removing these parts.

Figure 6 - 25
Heatsink Removal
10. Carefully remove the video card.

**Caution**
The heat sink, and video card area in general, contains parts which are subject to high temperatures. Allow the area time to cool before removing these parts.

*Figure 6 - 26*
Video Card Removal
Installing a New Video Card

1. Prepare to fit the video card into the slot by holding it at about a 30° angle.

2. The card needs to be fully into the slot, and the video card and socket have a guide-key and pin which align to allow the card to fit securely.

Contact Warning

Be careful not to touch the metal pins on the VGA card's connecting edge. Even the cleanest hands have oils which can attract particles, and degrade the module's performance.
3. Fit the connectors firmly into the socket, straight and evenly.
4. DO NOT attempt to push one end of the card in ahead of the other.

5. The card’s pin alignment will allow it to only fit one way. Make sure the module is seated as far into the socket as it will go (none of the gold colored contact should be showing). DO NOT FORCE the card; it should fit without much pressure.
Upgrading The Computer

6. Secure the card with screws 19 - 20 (Figure 6 - 25 on page 6 - 22).
7. Place the heatsink back on the card, and secure the screws in the order indicated in Figure 6 - 25 on page 6 - 22.
8. Attach the video card fan and secure with the screws as indicated in Figure 6 - 23 on page 6 - 21.
9. Reinsert the component bay cover, and secure with the screws as indicated in Figure 6 - 22 on page 6 - 20 (make sure you reconnect the fan cable before screwing down the bay cover).
Chapter 7: Modules

Overview

This chapter contains the information on the various modules (some of which are optional) which may come with your computer, depending on the configuration purchased. If you are unsure please contact your service representative.

The chapter includes information on the following:

- Setting Up SATA RAID Mode
- Bluetooth Module
- Wireless LAN Module
- PC Camera Module
- TV Tuner Module
- Fingerprint Reader Module
Setting Up SATA RAID Mode

To configure your system in Striping (RAID 0) or Mirroring (RAID 1) modes (see Table 7 - 1, on page 7 - 3) you will require at least two identical (see sidebar) hard disks.

Intel® Matrix Storage Manager

Make sure you install the Intel Matrix driver and application if you have set up your hard disk(s) in RAID mode (see “Intel® Matrix Driver Installation” on page 7 - 7).
Prepare the following before setting up your serial ATA hard disks in RAID mode:

1. The Microsoft Windows 7 OS DVD.
2. A second (identical) hard disk installed in the Primary HDD bay.
   OR
   A second (identical) hard disk installed in the Primary HDD bay, and a third (identical) hard disk in the Secondary HDD bay if required.

<table>
<thead>
<tr>
<th>RAID Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAID 0</td>
<td>Identical drives reading and writing data in parallel to increase performance. RAID 0 implements a striped disk array and the data is broken into blocks and each block is written to a separate disk drive.</td>
</tr>
<tr>
<td>RAID 1</td>
<td>Identical drives in a mirrored configuration used to protect data. Should a drive that is part of a mirrored array fail, the mirrored drive (which contains identical data) will handle all the data. When a new replacement drive is installed, data to the new drive is rebuilt from the mirrored drive to restore fault tolerance.</td>
</tr>
</tbody>
</table>

Table 7 - 1
RAID Levels

Array Types

A Mirrored Array (RAID 1) provides full data protection, as data can simply be copied from a healthy disk to a replacement for any failed disk.

A Striped Array (RAID 0) is NOT fault-tolerant. The failure of one drive will result in the loss of all data in the array. It is designed to increase disk performance by spreading the I/O load across the channels and drives.
SATA RAID Setup Procedure (BIOS)

1. Start-up your notebook computer and press <F2> to enter the BIOS.
2. Go to the Advanced menu, select "SATA Mode" and press Enter (see page 5 - 8).
   • Select “RAID”.
3. Press Esc and go to the Boot menu.
4. Set the DVD-ROM Drive (make sure the Microsoft Windows 7 OS DVD is inserted) as the first device in the boot order from the Boot menu.
5. Select Exit Saving Changes from the Exit menu (or press F10 and Enter) and press Enter to exit the BIOS and reboot the computer.
6. See the instructions in “RAID Setup (Intel Matrix)” on page 7 - 5.
RAID Setup (Intel Matrix)

1. As the computer starts up press Ctrl + i to enter RAID configuration menu.


3. Type the RAID volume name and then press Tab or Enter to advance to the next field.

4. Specify (use the up and down arrow keys) the RAID level (RAID 0 or RAID 1 - see Table 7 - 1, on page 7 - 3) and then press Tab or Enter to advance to the next field.

5. Press Enter and the system will select the physical disks to use.

6. Press Enter and select (if applicable) the Strip Size (best set to default).

7. Press Enter and select the Capacity size (best set to default).

8. Press Enter to select Create Volume.

9. Press Enter to create the volume, and confirm the selection by pressing Y.
10. This will now return to the main menu.

11. Select **6. Exit** and press Enter, then press **Y** to exit the RAID configuration menu.

12. Make sure the **Windows 7** OS DVD is in the DVD drive, and as the computer starts up it will automatically boot from the **Windows 7** OS DVD.

13. Click **Next** to continue installing the operating system as normal (see your **Windows** documentation if you need help on installing the **Windows** OS).

14. Install the **Windows** drivers from the **Device Drivers & Utilities + User’s Manual** disc as per **Table 4 - 1, on page 4 - 3** (make sure you install the Intel Matrix driver - see “**Intel® Matrix Driver Installation**” on page 7 - 7)

---

**Figure 7 - 2**

RAID Created

<table>
<thead>
<tr>
<th>RAID Volumes:</th>
<th>Level</th>
<th>Strip</th>
<th>Size</th>
<th>Status</th>
<th>Bootable</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID Name</td>
<td>Level</td>
<td>Strip</td>
<td>Size</td>
<td>Status</td>
<td>Bootable</td>
</tr>
<tr>
<td>0 MyRAID</td>
<td>RAID1 (Mirror)</td>
<td>N/A</td>
<td>111.7GB</td>
<td>Normal</td>
<td>Yes</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Physical Disks:</th>
<th>Port Drive Model</th>
<th>Serial #</th>
<th>Size</th>
<th>Type/Status (Vol ID)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 FUJITSU MHY2120B</td>
<td>K404T812P22B</td>
<td>111.7GB</td>
<td>Member Disk(0)</td>
<td></td>
</tr>
<tr>
<td>4 FUJITSU MHY2120B</td>
<td>K404T7C2JKJ14</td>
<td>111.7GB</td>
<td>Member Disk(0)</td>
<td></td>
</tr>
</tbody>
</table>
Intel® Matrix Driver Installation

1. Insert the *Device Drivers & Utilities + User’s Manual* disc into the CD/DVD drive.
2. Click **Option Drivers** (button).
3. Click **5.Install Matrix Driver > Yes**.
4. Click **Next > Next > Yes > Next**.
5. Click **Finish** to restart the computer.

The *Intel Matrix Storage Console* displays status information on your RAID configuration. Run the *Intel® Matrix Storage Console* from the *Intel® Matrix Storage Manager* in the Programs/All Programs menu. The *Intel® Matrix Storage Manager* provides information on the RAID status.

Figure 7-3
*Intel Matrix Storage Console* (Basic & Advanced Views)

e-SATA Port
Install the *Intel Matrix Storage* driver to display the safe removal icon for e-SATA devices in the taskbar.
Intel® Matrix Storage Manager

If a hard drive member of a RAID volume is reported as “Degraded” or “Failed” it may be possible to recover the volume. If the volume cannot be restored then you will need to recreate the RAID volume and restore the data from a back up. The Help menu (press F1 or select Contents and Index from the Help menu) provides instructions on how to recover or recreate RAID Volumes.

**Figure 7 - 4  Intel Matrix Storage Manager Help**
RAID Volume Data Verification and Repair

The RAID volume data verification process identifies any inconsistencies or bad data on a RAID 0 or RAID 1 volume. The table outlines what occurs for each RAID level:

<table>
<thead>
<tr>
<th>RAID Level</th>
<th>Verify</th>
<th>Verify &amp; Repair</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAID 0</td>
<td>Bad blocks are identified.</td>
<td>N/A</td>
</tr>
<tr>
<td>RAID 1</td>
<td>Bad blocks are identified.</td>
<td>Bad blocks are reassigned. If the data on the mirrored drive does not match the data on the source drive, the data on the mirrored drive is overwritten by the data on the source.</td>
</tr>
</tbody>
</table>

Data on the mirrored drive is compared to data on the source drive.

Replacing and Reverting Recovery and Master Volumes

If a master or recovery drive fails you will need to add a new identical drive and rebuild the recovery volume to the drive. You can also revert the master drive to the state of the previous volume update. For details on how to do this see “Intel Matrix Storage Manager Help” on page 7 - 8.

See over for details on how to verify and repair RAID volume data.
Verifying and Repairing RAID Volume Data
1. Run the Intel® Matrix Storage Console from the Intel® Matrix Storage Manager in the Programs/All Programs menu.
2. Click View > Advanced Mode.
3. Right-click on the RAID volume and select either Verify Volume Data or Verify and Repair Volume Data.

4. The verification or verification and repair process will run and display progress.
5. A dialog box will display the final status of the verification or verification and repair status.
Bluetooth Module

The optional Bluetooth module allows you to connect your computer to Bluetooth enabled devices such as other computers, desktop computers, mobile phones, printers, digital cameras, PDAs, headsets etc. using a short-range radio frequency.

Use the Fn + F12 key combination or Touch Sensor Instant Key to toggle power to the Bluetooth module. When the Bluetooth module is powered on, the LED will be highlighted and the indicator will briefly be displayed. The operating system’s Bluetooth Devices control panel is used to configure the Bluetooth settings in Windows Vista, and therefore does not require a driver.

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are OFF if you are using the computer aboard aircraft.

Use the Fn + F12 key combination/Touch Sensor Key to toggle power to the Bluetooth module, and check the LED to see if the module is powered on or not (see Table 1-3, on page 1-10 / Table 1-2, on page 1-8).

Bluetooth Data Transfer

Note that the transfer of data between the computer and a Bluetooth enabled device is supported in one direction only (simultaneous data transfer is not supported). Therefore if you are copying a file from your computer to a Bluetooth enabled device, you will not be able to copy a file from the Bluetooth enabled device to your computer until the file transfer process from the computer has been completed.

Bluetooth Module & Resuming From Sleep Mode

The Bluetooth module’s default state will be off after resuming from the Sleep power-saving state. Use the key combination (Fn + F12) to power on the Bluetooth module after the computer resumes from Sleep.
Bluetooth Configuration in Windows 7

Setup your Bluetooth Device so the Computer Can Find it
1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.
2. Make the device discoverable (to do this check your device documentation).

To Turn the Bluetooth Module On
1. Press the \textit{Fn + F12} key combination to power on the Bluetooth module.
2. A Bluetooth icon \textbullet{} will appear in the taskbar.
3. You can then do any of the following to access the \textit{Bluetooth Devices} control panel.
   - \textbf{Double-click} the taskbar icon \textbullet{} to access the \textit{Bluetooth Devices} control panel.
   - \textbf{Click/Right-click} the taskbar icon \textbullet{} and choose an option from the menu.

\textbf{Add a Device}
Click \textbf{Start}, and click \textbf{Control Panel} and then click \textbf{Devices and Printers (Hardware and Sound)}. Click \textbf{Add a device} to search for any available Bluetooth devices.

\textit{Add a Device}

\textbf{Figure 7 - 7}
\textbf{Bluetooth Devices & Click Icon Menu}
To Add a Bluetooth Device

1. Access the Bluetooth Devices control panel and click Add a device.
2. Double-click the device you want to pair with the computer.
3. On first connection the computer will provide you with a pairing code to be entered onto the device.

Pairing Options

If a device has been previously connected then the pairing option menu will appear when you attempt subsequent connections. You can choose to have the computer create a pairing code for you, use the device’s existing pairing code or you can pair certain devices without using a code.

Figure 7 - 8
Add a Device
4. Enter the code into your Bluetooth enabled device and follow any on-screen instructions to complete the pairing.

5. **Windows** will check to see if any drivers are required to complete the pairing.
6. Follow any on-screen instructions on the computer if device drivers are required to be installed.
7. Click Close.

---

**Pairing Codes**

The example outlined here shows a connection to a mobile device. Other devices e.g. computers, may have a slightly different connection procedure, and may require you to confirm a pairing code is correct on both devices. Follow the on-screen instructions to complete the pairing.
To Change Settings for the Bluetooth Device
1. Click the taskbar icon and select Show Bluetooth Devices.
2. Right-click on the device you want to change and click Properties to:
   • Change the name of the device (click Bluetooth, type a new name and click OK).
   • Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

To Make your Computer Discoverable to Bluetooth Devices
1. Click the taskbar icon and select Open Settings.
2. Click Options, and make sure that Allow Bluetooth devices to find this computer check box (Discovery) has a tick inside it.
3. Make sure that the Alert me when a new Bluetooth device wants to connect check box (Connections) has a tick inside it, if you want to be notified when a Bluetooth device wants to connect.

To get help on Bluetooth configuration and settings, select Help and Support from the Start menu. Type Bluetooth in the Search Help box, and select an item from the returned search results to get more information.
Wireless LAN Module

If you have included an Intel® Wi-Fi Link 5300 Series, Intel® Advanced N Wi-Fi Link 6200, Intel® Ultimate N Wi-Fi Link 6300 module or 3rd Party 802.11b/g/n WLAN module in your purchase option, make sure that the Wireless LAN module is on before installing the driver.

Use the Fn + F11 key combination or Touch Sensor Instant Key to toggle power to the Wireless LAN module. When the WLAN module is powered on, the LED will be highlighted and the indicator will briefly be displayed. Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3. The operating system is the default setting for Wireless LAN control in Windows 7.
Intel® Wi-Fi Link Series Driver Installation

If you see the message “Found New Hardware” click Cancel to close the window.

1. Make sure the module is powered on, then insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive.
2. Click Option Drivers (button).
3. Click 1.Install Wireless Lan Driver > Yes.
4. An on-screen message will appear to show the progress of the WLAN installation.
5. When the message disappears the driver will be installed.

Note: The operating system is the default setting for Wireless LAN control in Windows 7 (see overleaf).

802.11b/g/n Driver Installation

1. Make sure the module is powered on, then insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive.
2. Click Option Drivers (button).
3. Click 1.Install Wireless Lan Driver > Yes.
4. Choose the language you prefer and click Next.
5. Click Next > Install.
6. Click Finish to restart the computer.

Note: The operating system is the default setting for Wireless LAN control in Windows 7 (see overleaf).
Connecting to a Wireless Network in Windows 7

Make sure the Wireless LAN module is turned on.

1. **Click** the taskbar wireless icon, and then double-click an access point to connect to or click to **Open Network and Sharing Center** if you do not see a network you want to connect to in the taskbar menu (a list of options will appear allowing setting changes, and creating a new network).

*Figure 7-12*  
Click Taskbar Icon Menu & Network and Sharing Center
2. You may need to enter a security key for any access point to which you are trying to connect.
3. Click to select a network location (e.g. Home, Work or Public).
4. Click "View or change settings in Network and Sharing Center" to access further options for the connection.

Figure 7 - 13
Network Location Set
5. Click the taskbar icon to see any currently connected networks.
6. To disconnect from the wireless network you can click the taskbar wireless icon, click the active connection and then click Disconnect (button).

Security Enabled Networks

You should try to make sure that any network you are connecting to is a secure network.

Connecting to unsecure networks may allow unauthorized access to your computer, documents, websites and files etc.

Figure 7 - 14
Click Taskbar Icon
Menu - Disconnect
Windows Mobility Center

The Windows Mobility Center control panel provides an easy point of access for information on battery status, power plans used and wireless device status etc.

To access the Windows Mobility Center:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click Windows Mobility Center (Mobile PC).
3. Click the button to Turn wireless off/on, or click the icon to access the network menu.

Figure 7 - 15
Windows Mobility Center
PC Camera Module

Before installing the driver, make sure the PC Camera is on. **Use the Fn + F11 key combination or Touch Sensor Instant Key** to toggle power to the to the PC Camera module. When the PC Camera module is powered on, the LED will be highlighted and the indicator will briefly be displayed. Make sure you install the drivers in the order indicated in *Table 4-1, on page 4-3*.

**PC Camera Driver Installation**

1. Insert the *Device Drivers & Utilities + User’s Manual* disc into the CD/DVD drive.
2. Click **Option Drivers** (button).
3. Click **2.Install WebCam Driver > Yes**.
4. Choose the language you prefer and click **Next > Next**.
5. Click **Finish** to restart the computer.
6. Run the camera application program from the shortcut on the desktop (if the hardware is turned off use the Fn + F10 key combination to turn it on again).
PC Camera Audio Setup

If you wish to capture video & audio with your camera, it is necessary to setup the audio recording options in Windows.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Sound (Hardware and Sound).
3. Click Recording (tab).
4. Right-click Microphone (Realtek High Definition Audio) and make sure the item is not disabled.
5. Double-click Microphone (or select Properties from the right-click menu).
6. Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to the level required.
7. Click OK and close the control panels.
8. Run the camera application program from the desktop shortcut.
9. Go to the Devices menu heading and select Microphone (Realtek....) (it should have a tick alongside it).
10. Go to the Capture menu heading and select Capture Audio (it should have a tick alongside it).
Figure 7 - 16
Audio Setup for PC Camera
Camera Application

The WebCam application is a video viewer for general purpose video viewing and testing, and for capturing video files to .avi format.

1. Run the camera application from the desktop shortcut (it is recommended that you set the capture file before the capture process - see below).
2. Go to the Capture menu heading (if you wish to capture audio check “PC Camera Audio Setup” on page 7 - 23) and select Start Capture.
3. Click OK/Yes (the file location will be displayed in the pop-up box) to start capturing the video, and press Esc to stop the capture (you can view the file using the Windows Media Player).

Set Capture File

Prior to capturing video files you may select the Set Capture File... option in the File menu, and set the file name and location before capture (this will help avoid accidentally overwriting files). Set the name and location then click Open, then set the "Capture file size:" and click OK. You can then start the capture process as on the previous page.

Note the important information in “Reducing Video File Size” on page 7 - 26 in order to save file space, and help prevent system problems.
Reducing Video File Size

Note that capturing high resolution video files requires a substantial amount of disk space for each file. After recording video, check the video file size (right-click the file and select Properties) and the remaining free space on your hard disk (go to My Computer, right-click the hard disk, and select Properties). If necessary you can remove the recorded video file to a removable medium e.g. CD, DVD or USB Flash drive.

Note that the Windows system requires a minimum of 15GB of free space on the C: drive system partition. In order to prevent system problems it is recommended that you save the captured video file to a location other than the C: drive (see “Set Capture File” on page 7 - 25), limit the file size of the captured video (see “Pre-Allocating File Size/Space” on page 7 - 25) or reduce video resolution (see below).

To Reduce Video Resolution Output Size:

1. Run the camera application program from the desktop shortcut.
2. Go to Options and scroll down to select Video Capture Pin....
3. Click the Output Size drop box and select a lower resolution size in order to reduce the captured file size.
4. Click OK.
Eliminating Screen Flicker
If you find that the video screen in the camera program is flickering, you can try to adjust the setting in the Video Capture Filter options.

1. Run the camera program from the desktop shortcut.
2. Go to Options and scroll down to select Video Capture Filter....
3. Click either 50Hz or 60Hz under Frequency in Property Page (tab).

Figure 7 - 17
Video Capture Filter (Property Page)
Modules

Zoom
The WebCam program allows you to zoom the camera in and out.

1. Run the camera application from the desktop shortcut.
2. Go to Zoom and select Zoom Out/Zoom In.

Taking Still Pictures
The WebCam program allows you to take still pictures.

1. Run the camera application from the desktop shortcut.
2. Go to Options and select Take Picture.
3. The picture (in JPEG format) will be placed in the Snapshot folder on the desktop.

Snapshot Folder
The Snapshot folder's default location is on the desktop. Do not move this folder or an error may appear when you try to take a still picture.

If you accidentally delete or move the folder, you can create a new Snapshot folder on the desktop in order to capture the files.
TV Tuner Module

If your purchase configuration includes the **optional Hybrid** (Analog & Digital) USB Mini-Card TV Tuner module, you will be supplied with a remote control unit and appropriate antenna and fittings for the module. Software support for the TV Tuner module is provided by *Windows Media Center* in *Windows 7* (*not included in Starter or Home Basic versions*). A driver is provided on the *Device Drivers & Utilities + User’s Manual* disc for the remote control supplied with the TV Tuner.

The optional TV Tuner allows you to watch TV, play music CDs, video conference and capture still images and video on your PC.

The Cable (CATV) antenna will only be enabled when a TV Tuner module is installed. Make sure you connect the TV antenna.

---

**Figure 7 - 19**
**TV Tuner Ports/Jacks**
1. Consumer Infrared Transceiver
2. CATV Antenna Jack
**Consumer Infrared Driver**
1. Insert the *Device Drivers & Utilities + User’s Manual* disc into the CD/DVD drive.
2. Click **Option Drivers** (button).
3. Click **3.Install CIR Driver > Yes**.
4. Choose the language you prefer and click **Next > Next**.
5. Click **Finish** to restart the computer.

**Windows Media Center**
1. This TV Tuner module is fully supported by *Windows Media Center* in *Windows 7* (not included in Starter or Home Basic versions).
2. Run *Windows Media Center* directly from the **Start** menu (**Start** > **Programs** > **Windows Media Center**).
3. *Windows Help and Support* provides information on the *Windows Media Center* functions. Click **Start** and select **Help and Support**, and then type “**Media Center**” in the **Search Help** box and click the magnifying glass icon **🔍** to bring up the results.
Digital TV Broadcast Signal
The antenna is the most crucial factor in receiving a clear digital terrestrial TV broadcast signal. The passive antenna provided should provide a clear signal when placed beside a window. If the signal is not clear then you can purchase an active antenna (it should also be placed beside a window) to improve the signal. You should also check with any related government website which provides information on digital terrestrial TV coverage for your area. Note that (unlike standard analog TV) if the digital signal is weak then no picture will appear on the TV at all.

TV Recording and Power Plans
If you intend to use the optional TV Tuner to record live TV, then go to the Power Options control panel and create a power plan (see “Power Plans” on page 3 - 4) to prevent the power saving options from adjusting the computer’s performance level.

Remote Control Unit
The remote control unit allows you to remotely start and send the system into a power saving state, to run Windows Media Center and to navigate the Media Center menus etc. The remote control unit also gives full control over all TV and video functions.

CATV Cable Safety
Make sure that your CATV system installer has connected the Coaxial cable shield to the grounding system of the building, as close to the point of cable entry as practical.

This reminder is provided to call the CATV system installer’s attention to Article 820-93 of the NEC (Section 54, Part I of the Canadian Electrical Code).
Fingerprint Reader Module

The **optional fingerprint reader Protector Suite Software** provides a high level of security for your computer. A further level of security and control is provided in the BIOS (see “Security Menu” on page 5 - 10).

The **fingerprint reader** and **Protector Suite Software** allow you to:
- Access or Lock your computer
- Protect sensitive files
- Display and file your favorite web pages
- Fill in frequently used dialogs
- Run your favorite applications

If you have included the fingerprint reader in your purchase option you will need to install the driver as per the instructions below.

Make sure you have administrator’s rights to your computer, and have a Windows password enabled for full security protection.

Before beginning the enrollment process it is recommended that you go through the fingerprint tutorial. To run the tutorial click **Start > Programs/All Programs > Protector Suite QL > Fingerprint Tutorial** after installing the driver.
Fingerprint Reader Driver Installation

1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive.
2. Click Option Drivers.
3. Click 4.Install Fingerprint Driver > Yes.
4. Windows will configure Protector Suite 2009 and automatically restart the computer.
5. Click the tray icon , scan a finger or click Start > Programs/All Programs > Protector Suite > Control Center and then begin the enrollment process (see over).
User Enrollment

1. Click Start > Programs/All Programs > Protector Suite > Control Center, or double click the taskbar icon (click Initialize).
2. On the first run of the program you will be asked to click the Accept button to accept the license.
3. If you have not set a Windows password you will be prompted to do so (note: If you have not set a password Protector Suite cannot secure access to your computer).
4. Click Submit when you have entered password.
5. You will then be prompted to enroll your fingerprints (you can click Tutorial to get help with fingerprint enrollment at any time).

Fingerprint Enrollment

Note that it is strongly recommended that you enroll more than one finger in case of injury etc.
6. Click the button above any of the fingers to begin the enrollment process for that finger.
7. Swipe the finger until the progress bar reaches 100% to enroll that finger.


Note that it is strongly recommended that you enroll more than one finger in case of injury etc.
9. Right-click the taskbar icon and select **Start Control Center** (and then swipe a finger) to allow you to **Edit Fingerprints**, register **Applications**, edit **Settings** and access the **Help** menu etc. You can also run the **Control Center** etc. from the **Protector Suite** item in the **Programs/All Programs** menu.

10. Click “**Help**” to get more information on any topic.

11. You can also run the **Tutorial**, or **Product Tour** video to get more information.

12. If you swipe your finger over the reader at any time you can access the **Biomenu** to **lock the computer**, **register websites**, access the **Personal Safe**, open the **Control Center** and access the **Help** menu.
Fingerprint Control Center Features

Application Launcher
The Application Launcher allows you to register applications to be launched when assigned to a particular finger. Simply copy the application icon on to one of the registered fingers and then click OK to close the application window. Once registered the application will launch when you swipe the appropriate finger across the sensor.

Password Bank
The Password Bank stores registrations of user names, passwords and other settings for websites etc.

Personal Safe
The Personal Safe is an encrypted area assigned on your hard drive that allows you to store files and folders to be protected by fingerprint protection.
Chapter 8: Troubleshooting

Overview

Should you have any problems with your computer, before consulting your service representative, you may want to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface. If all else fails, talk to your service representative. You should also make a record of what happened and what remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call your service representative.
Troubleshooting

Basic Hints and Tips

Many of the following may seem obvious but they are often the solution to a problem when your computer appears not to be working.

- **Power** - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip, make sure it is actually working. Check the LED Power Indicators (see “LED Indicators” on page 1 - 7) to see the computer’s power status.

- **Connections** - Check all the cables to make sure that there are no loose connections anywhere.

- **Power Savings** - Make sure that the system is not in Hibernate or Sleep mode by pressing the keys configured in your Power Options (see “Configuring the Power Buttons” on page 3 - 8), the Fn + F4 key combination, or power button to wake-up the system.

- **Brightness** - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the brightness (see Table 1 - 3, on page 1 - 10).

- **Display Choice** - Press Fn + F7 to make sure the system is not set to “external only” display.

- **Boot Drive** - Make sure there are no optical media and/or USB storage devices in any connected drive when you start up your machine (this is a common cause of the message “Invalid system disk - Replace the disk, and then press any key” / “Remove disks or other media. Press any key to restart”).

8 - 2 Basic Hints and Tips
Backup and General Maintenance

• Always **backup** your important data, and keep copies of your OS and programs safe, but close to hand. Don’t forget to note the **serial numbers** if you are storing them out of their original cases, e.g. in a CD wallet.

• Run **maintenance programs** on your hard disk and OS as often as you can. You may schedule these programs to run at times when you are not using your computer. You can use those that are provided free with your OS, or buy the more powerful dedicated programs to do so.

• Write down your passwords and keep them safe (away from your computer). This is especially important if you choose to use a **Boot** password for the SCU (see “Security Menu” on page 5 - 10).

• Keep copies of vital **settings files** such as network, dialup settings, mail settings etc. (even if just brief notes).

---

**Warranty**

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your warranty.
**Troubleshooting**

**Viruses**

- Install an **Anti-Virus** program and keep the **definitions file** (the file which tells your program which viruses to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm your computer and cause you to lose data. **Anti-Virus** programs are commercially available and the **definitions file updates** are usually downloadable directly from the internet.

- Be careful when opening e-mail from sources you don’t know. **Viruses** are often triggered from within **e-mail attachments** so take care when opening any attached file. You can configure most **Anti-Virus** programs to check all **e-mail attachments**. **Note**: You should also beware of files from people you know as the virus may have infected an **address book** and been automatically forwarded without the person’s knowledge.

- Keep a “**Bootable CD-ROM/DVD-ROM/USB storage device**” (this CD/DVD/USB device provides basic information which allows you to startup your computer) handy. You may refer to your OS’s documentation for instructions on how to make one, and many **Anti-Virus** programs will also provide such a disk (or at least instructions on how to make one).
Upgrading and Adding New Hardware/Software

- Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are doing, otherwise you will risk severely damaging your system.

- Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what you are doing.

- Read the documentation. We can assume, since you are reading this that you are looking at the computer’s manual, but what about any new peripheral devices you have just purchased? Many problems are caused by the installation of new hardware and/or software. Always refer to the documentation of any new hardware and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

- When installing a new device always make sure the device is powered on, and in many cases you will need to restart the computer. Always check that all the cables are correctly connected.

- Make sure you have installed the drivers for any new hardware you have installed (latest driver files are usually available to download from vendor’s websites).

- Thoroughly check any recent changes you made to your system as these changes may affect one or more system components, or software programs. If possible, go back and undo the change you just made and see if the problem still occurs.
Troubleshooting

- Don’t over complicate things. The less you have to deal with then the easier the source of the problem may be found; **Example** - if your computer has many devices plugged into its ports, and a number of programs running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices and restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and removing devices and restarting where necessary) will often find the source of a problem, although this may be time consuming.
## Problems & Possible Solutions

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You turned the <strong>power on</strong> but it doesn’t work.</td>
<td><em>Battery missing / incorrectly installed.</em> Check the battery bay, make sure the battery is present and seated properly (the design of the battery only allows it to go in one way). Make sure there’s nothing interfering with the battery contacts.</td>
</tr>
<tr>
<td>The <strong>Battery LED power indicator</strong> 📀, is blinking orange.</td>
<td><strong>Low Battery.</strong> Plug in the AC power source. If the computer doesn’t start up immediately, turn it off then on again.</td>
</tr>
<tr>
<td>You are losing <strong>battery power</strong> too quickly.</td>
<td><strong>The system is using too much power.</strong> If your OS has a <em>Power Options</em> scheme (see “<strong>Power Plans</strong>” on page 3 - 4) check its settings. You may also be using an ExpressCard device/USB device/external device that is drawing a lot of power.</td>
</tr>
<tr>
<td></td>
<td><strong>You are attempting to run an SLI configuration on battery power.</strong> Due to the high power and system demands created by enabling SLI Configuration, you <strong>should not enable SLI configuration if your computer is powered by battery only.</strong></td>
</tr>
<tr>
<td>Actual <strong>battery operating time</strong> is shorter than expected.</td>
<td><strong>The battery has not been fully discharged before being recharged.</strong> Make sure the battery is fully discharged and recharge it completely before reusing (see “<strong>Battery Information</strong>” on page 3 - 10).</td>
</tr>
<tr>
<td></td>
<td>Check the settings of any active power plan (see “<strong>Power Plans</strong>” on page 3 - 4).</td>
</tr>
<tr>
<td></td>
<td>A <strong>peripheral device/USB device is consuming a lot of power.</strong> Turn off/remove the unused device to save power.</td>
</tr>
</tbody>
</table>
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The computer feels too hot.</td>
<td>Make sure the computer is properly ventilated and the vents/fan intakes are not blocked. If this doesn’t cool it down, put the system into Hibernate mode or turn it off for an hour. Make sure the computer isn’t sitting on a thermal surface (see “Overheating” on page 1 - 15). Make sure you’re using the correct adapter. Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a notebook which is powered on in a travel bag may cause the vents/fan intakes to be blocked.</td>
</tr>
<tr>
<td>Nothing appears on screen.</td>
<td>The system is in a power saving mode. Toggle the Fn + F4 (see “Configuring the Power Buttons” on page 3 - 8).</td>
</tr>
<tr>
<td></td>
<td>The screen controls need to be adjusted. Toggle the screen control Fn + F8/F9 key combinations.</td>
</tr>
<tr>
<td></td>
<td>If you’re connected to an external monitor, make sure it’s plugged in and turned on. You should also check the monitor’s own brightness and contrast controls.</td>
</tr>
<tr>
<td></td>
<td>The computer is set for a different display. Toggle the screen display key Fn + F7 combination. If an external monitor is connected, turn it on.</td>
</tr>
<tr>
<td></td>
<td>The screen saver is activated. Press any key or touch the TouchPad.</td>
</tr>
<tr>
<td>No image appears on the external monitor I have plugged in and powered on.</td>
<td>You haven’t installed the video driver and configured it appropriately from the Control Panel. See “NVIDIA Video Driver Controls” on page B - 1 for instructions on installing and configuring the video driver.</td>
</tr>
</tbody>
</table>
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You forget the boot password.</td>
<td>If you forget the password, you may have to discharge the battery of the CMOS. Contact your service representative for help.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Password Warning</strong></td>
<td>If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>The sound cannot be heard or the volume is very low.</td>
<td>The volume might be set too low. Check the volume control in the <strong>Volume Control Panel</strong> in the Windows taskbar, use the key combination <strong>Fn + F5</strong> and <strong>F6</strong> or move your finger slowly along the volume control slider to adjust the system volume (see “Audio Features” on page 2 - 16/“Touch Sensor Instant Keys” on page 1 - 8) to adjust.</td>
</tr>
<tr>
<td>The compact disc cannot be read.</td>
<td>The compact disc is dirty. Clean it with a CD-ROM cleaner kit.</td>
</tr>
<tr>
<td>The compact disc tray will not open when there is a disc in the tray.</td>
<td>The compact disc is not correctly placed in the tray. Gently try to remove the disc using the eject hole (see “Loading Discs” on page 2 - 3).</td>
</tr>
<tr>
<td>The DVD regional codes can no longer be changed.</td>
<td>The code has been changed the maximum 5 times. See “DVD Regional Codes” on page 2 - 5.</td>
</tr>
</tbody>
</table>

---

**Problems & Possible Solutions 8 - 9**
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The TouchPad doesn’t work.</td>
<td><em>The Touchpad has been disabled.</em> Press the Touchpad toggle (Fn + F1) key combination (make sure you have installed the Touchpad driver).</td>
</tr>
<tr>
<td>The system freezes or the screen goes dark.</td>
<td><em>The system’s power saving features have timed-out.</em> Use the AC/DC adapter, press a key on the keyboard, or press the sleep (Fn + F4) key combination, or press the power button if no LEDs are lit.</td>
</tr>
<tr>
<td>The system never goes into a power saving mode.</td>
<td>Power Options features are not enabled. Go to the Windows Power Options menu and enable the features you prefer (see “Power-Saving States” on page 3 - 6). Make sure you have enabled Hibernate mode from the control panel.</td>
</tr>
<tr>
<td>The Wireless LAN/Bluetooth/PC Camera modules cannot be detected.</td>
<td><em>The modules are off.</em> Check the appropriate Touch Sensor indicator to see if the modules are on or off (see “Touch Sensor Instant Keys” on page 1 - 8). If the LED indicator is not illuminated, then press the appropriate touch sensor instant key/function key combination in order to enable the modules.</td>
</tr>
<tr>
<td>The Wireless LAN/Bluetooth/PC Camera modules cannot be configured.</td>
<td><em>The driver(s) for the module(s) have not been installed.</em> Make sure you have installed the driver for the appropriate module (see the instructions in Chapter 7 “Modules” for the appropriate module).</td>
</tr>
</tbody>
</table>
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>When a <strong>DVD</strong> is played in <strong>Windows Media Player/Media Center</strong>, the <strong>audio track</strong> in other languages (commentaries etc.) is <strong>not clear</strong> if connected to the <strong>S/PDIF-Out Jack</strong>.</td>
<td><em>This is an issue with Windows Media Player/Media Center and audio output through the S/PDIF-Out Jack. We recommend that you use the <strong>Power DVD</strong> application to play DVDs.</em></td>
</tr>
<tr>
<td>Nothing appears on the screen when the <strong>PC Camera</strong> software is run.</td>
<td><em>You have selected an external display as the default display device.</em> The PC Camera application software needs to be run while the <strong>default notebook LCD</strong> is the selected display device. After a camera picture is obtained on the default notebook LCD, you may then use the <strong>Fn + F7</strong> to toggle through the display modes (give the screen time to refresh). If you have selected an external display as your display device do not run the PC Camera software application until you have switched back to the notebook LCD.</td>
</tr>
<tr>
<td>A file cannot be copied to/from a connected <strong>Bluetooth</strong> device.</td>
<td><strong>The transfer of data between the computer and a Bluetooth enabled device is supported in one direction only (simultaneous data transfer is not supported).</strong> If you are copying a file from your computer to a Bluetooth enabled device, you will not be able to copy a file from the Bluetooth enabled device to your computer until the file transfer process from the computer has been completed</td>
</tr>
<tr>
<td>The <strong>Bluetooth</strong> module is <strong>off</strong> after resuming from <strong>Sleep</strong>.</td>
<td><em>The Bluetooth module’s default state will be off after resuming from the Sleep power-saving state.</em> Use the key combination (<strong>Fn + F12</strong>) to power on the Bluetooth module after the computer resumes from Sleep.</td>
</tr>
</tbody>
</table>
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>No sound</strong> can be heard through an HDMI connected display device.</td>
<td>You have not configured the HDMI audio output. See “HDMI Audio Configuration” on page 2 - 13.</td>
</tr>
</tbody>
</table>
| After installing the cardreader driver you receive the error message “0x000000D1” and the computer may restart. | Where this is the case, install the beta cardreader driver version provided on the **Device Drivers & Utilities +User's Manual disc**.  
1. **Insert the Device Drivers & Utilities + User’s Manual disc** and click **Browse CD/DVD**.  
2. The driver is located in the following location on the disc: **Driver\07_CReader(Beta)**.  
3. Double-click the executable setup file and follow the on-screen instructions to install the driver. |
| You are experiencing problems with an external display connected to the DVI-Out port. | Where this is the case, install the beta video driver version provided on the **Device Drivers & Utilities +User's Manual disc**.  
1. **Insert the Device Drivers & Utilities + User’s Manual disc** and click **Browse CD/DVD**.  
2. The driver is located in the following location on the disc: **Driver\02_Video(Beta)**.  
3. Double-click the executable setup file and follow the on-screen instructions to install the driver. |
After using the **Fn + F11** key combination to switch the WLAN module off and have, restarted the computer, shut the computer down and started up again, or recovered from hibernate mode, you experience problems with powering the WLAN module on again.

This is a known problem and Intel have provided a beta WLAN driver to address this issue. The beta WLAN driver is provided on the **Device Drivers & Utilities + User’s Manual disc**.

1. **Insert the Device Drivers & Utilities + User’s Manual disc** and click **Browse CD/DVD**.
2. The driver is located in the following location on the disc: **Others\01_WLan\Shirley(Beta)**
3. Use the **Fn + F11** key combination to **power ON** the WLAN module **before installing the driver** (check the LED indicator to make sure the WLAN module is ON).
4. Double-click the executable setup file and follow the on-screen instructions to install the driver.
Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You have a RAID enabled and the system will not boot to <em>Windows</em></td>
<td>You may need to recover the RAID volumes.</td>
</tr>
<tr>
<td></td>
<td>1. As the computer starts up press <em>Ctrl</em> + <em>i</em> to enter RAID configuration menu</td>
</tr>
<tr>
<td></td>
<td>2. If the RAID volume’s <em>Physical disks</em> are marked in red, then press <em>4.Recovery Volume Options</em>.</td>
</tr>
<tr>
<td></td>
<td>3. If you cannot access <em>4.Recovery Volume Options</em> (i.e. it is grayed out) then press <em>5.Acceleration Options</em>.</td>
</tr>
<tr>
<td></td>
<td>4. Press <em>Enter</em> and return to the main menu, then press <em>4.Recovery Volume Options</em>.</td>
</tr>
<tr>
<td></td>
<td>5. Follow the on screen instructions to recover the <em>Physical disks</em>.</td>
</tr>
<tr>
<td></td>
<td>6. If only one of the physical disks now appears green, then press <em>6.Exit</em> to save the changes and exit and boot to <em>Windows</em>.</td>
</tr>
<tr>
<td></td>
<td>7. When Windows is loaded run the <em>Intel® Matrix Storage Console</em> from the <em>Intel® Matrix Storage Manager</em> in the <em>Programs/All Programs</em> menu.</td>
</tr>
<tr>
<td></td>
<td>8. Click <em>View &gt; Advanced Mode</em>.</td>
</tr>
<tr>
<td></td>
<td>9. Right-click on the RAID volume and select either <em>Verify Volume Data</em> or <em>Verify and Repair Volume Data</em>.</td>
</tr>
<tr>
<td></td>
<td>10. The verification or verification and repair process will run and display progress.</td>
</tr>
<tr>
<td></td>
<td>11. A dialog box will display the final status of the verification or verification and repair status.</td>
</tr>
</tbody>
</table>
Appendix A: Interface (Ports & Jacks)

Overview

The following chapter will give a quick description of the ports & jacks which allow your computer to communicate with external devices, connect to the internet etc.
## Ports and Jacks

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Card Reader</td>
<td>The card reader allows you to use the following digital storage cards:</td>
</tr>
<tr>
<td>MMC / SD / MS</td>
<td>- MMC (MultiMedia Card)</td>
</tr>
<tr>
<td></td>
<td>- SD (Secure Digital)</td>
</tr>
<tr>
<td></td>
<td>- MS (Memory Stick)</td>
</tr>
<tr>
<td></td>
<td>- MS (Memory Stick Pro)</td>
</tr>
<tr>
<td></td>
<td>- RS MMC (requires PC adapter)</td>
</tr>
<tr>
<td></td>
<td>- Mini SD (requires PC adapter)</td>
</tr>
<tr>
<td></td>
<td>- MS Duo (requires PC adapter)</td>
</tr>
<tr>
<td>Cable (CATV) Antenna Jack</td>
<td>Use this jack to connect a CATV cable if you have included the optional Mini-PCI TV Tuner in your purchase.</td>
</tr>
<tr>
<td>CATV</td>
<td>The consumer infrared transceiver at the front of the computer allows the computer to communicate with the remote control unit supplied with the optional Mini-PCI TV Tuner.</td>
</tr>
<tr>
<td>Consumer Infrared Transceiver</td>
<td></td>
</tr>
<tr>
<td>DC-In Jack</td>
<td>Plug the supplied AC/DC adapter into this jack to power your computer.</td>
</tr>
<tr>
<td>DVI-Out Port</td>
<td>The DVI-Out (Digital Visual Interface) Port is a video connector interface. This allows you to connect an external monitor, TV or Flat Panel Display etc. as a display device (see &quot;Configuring an External Display using the NVIDIA Control Panel&quot; on page B - 7) by means of a DVI cable. If you are using an older type of monitor you will need to use a converter to convert the signal from DVI to VGA.</td>
</tr>
</tbody>
</table>
### Interface (Ports & Jacks)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>e-SATA/USB Port</td>
<td>This is a combined e-SATA (external Serial Advanced Technology Attachment)/ USB 2.0 compatible port. Plug external Serial ATA hard drives into this e-SATA (external Serial Advanced Technology Attachment) port. See “USB 2.0/1.1 Ports” on page A - 5 for USB port information.</td>
</tr>
<tr>
<td>HDMI-Out Port</td>
<td>The HDMI-Out (High-Definition Multimedia Interface) port is an audio/video connector interface for transmitting uncompressed digital streams. This allows you to connect an external monitor, TV or Flat Panel Display etc. as a display device (see “Configuring an External Display using the NVIDIA Control Panel” on page B - 7) by means of a HDMI cable. Note that HDMI carries both audio and video signals (see “HDMI Audio Configuration” on page 2 - 13).</td>
</tr>
<tr>
<td>HDMI-IN Port</td>
<td>The HDMI-In (High-Definition Multimedia Interface) port allows you to display external sources such as Blu-ray players, DVDs, set top boxes and games consoles etc. on your computer screen (see “GameMate Media Player (HDMI-In)” on page 2 - 10).</td>
</tr>
<tr>
<td>Headphone-Out Jack</td>
<td>Headphones or speakers may be connected through this jack. Note: Set your system’s volume to a reduced level before connecting to this jack.</td>
</tr>
<tr>
<td>Line-In Jack</td>
<td>The Line-In jack allows you to play audio sources through the computer’s speakers. Note that audio input through Line-in will default to the mute setting. To set up your audio sources to play through the Line-in jack go to the Sound control panel and make sure the Mute box is not ticked.</td>
</tr>
</tbody>
</table>
## Interface (Ports & Jacks)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microphone-In Jack</td>
<td>Plug an external microphone in to this jack to record on your computer.</td>
</tr>
<tr>
<td>Mini-IEEE 1394 Port</td>
<td>This allows high-speed connection to various peripheral devices, e.g. external disk drives and digital cameras (see note below).</td>
</tr>
</tbody>
</table>
| RJ-45 LAN Jack       | This port supports LAN (Network) functions.  
**Note:** Broadband (e.g. ADSL) modems usually connect to the LAN port. |
| S/PDIF-Out Jack      | This S/PDIF (Sony/Philips Digital Interface Format) Out Port allows you to connect your DVD-capable PC to a Dolby AC-3 compatible receiver for “5.1” or ‘dts’ surround sound. |
| Security Lock Slot   | To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be purchased at any computer store. |

**IEEE 1394**  
The Mini-IEEE 1394 ports only support **SELF POWERED** IEEE 1394 devices.
### Interface (Ports & Jacks)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB 2.0/1.1 Ports</td>
<td>These USB (<a href="https://en.wikipedia.org/wiki/Universal_Serial_Bus">Universal Serial Bus</a>) 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as external HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged into the computer, and unplugged from the computer, without the need to turn the system off (if the power rating of your USB device is 500mA or above, make sure you use the power supply which comes with the device).</td>
</tr>
</tbody>
</table>
Interface (Ports & Jacks)
Appendix B: NVIDIA Video Driver Controls

The basic settings for configuring the LCD are outlined in “Video Features” on page 1-17.

NVIDIA Video Driver Installation

Make sure you install the drivers in the order indicated in Table 4-1, on page 4-3.

1. Insert the Device Drivers & Utilities + User’s Manual disc and click Install Drivers (button).
2. Click 1.Install Video Driver > Yes.
3. Click Next > Yes > Next.
4. Click Finish to restart the computer.

Video Card Options

Note that card types, specifications and drivers are subject to continual updates and changes. Check with your service center for the latest details on video cards supported.
NVIDIA Video Driver Controls

NVIDIA Control Panel (Win 7)

More advanced video configuration options are provided in the NVIDIA Control Panel tab.

1. Open the Display Settings (see page 1 - 17) control panel.
2. Click Advanced Settings (button).
3. Click GeForce.... (tab).
4. Click Start the NVIDIA Control Panel to make any video adjustments.

OR

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click NVIDIA Control Panel (click "Classic View" from the left of the menu if you are in Control Panel Home).

Figure B - 1
NVIDIA GeForce..... Control Panel
The **NVIDIA Control Panel** provides additional video configuration controls and tools which allow quick access to features such as display configuration, 3D Settings and Help menus etc.

Navigating the Control Panel

Navigate through the control panels in much the same way as you would a web page. Click on the sub-heading tasks in the left menu (and on the highlighted links) for information. Use the buttons on the top left to go back, forward etc.

*Figure B - 2  
NVIDIA Control Panels*
The **Help** menus provide index and search features, and direct links to the NVIDIA website etc.

*Figure B - 3*  
**Help Menu**
Display Devices

Note that you can use a DVI cable connected to the DVI-Out port, or an HDMI (High-Definition Multimedia Interface) cable connected to the HDMI-Out port to connect an external display (if you are using an older type of monitor you can use a converter to convert the signal from DVI to VGA). See your display device manual to see which formats are supported.

1. The built-in LCD.
2. An external display connected to the DVI-Out Port.
3. An external display/TV (if the TV supports an HDMI connection) connected to the HDMI-Out Port.

Monitor and TV Tuner

If you are connecting both a monitor/flat panel display to the DVI-Out Port, and a cable/aerial to the optional TV Tuner module, make sure you attach the cable/aerial to the TV Tuner first, then the monitor.

DO NOT use the Fn + F7 key combination to toggle through display options when SLI is enabled.
Display Modes

Single Display Mode
Only one of your displays is used.

Duplicate Displays
Duplicate simply shows an exact copy of the Primary display desktop on the other display(s). This mode will drive multiple displays with the same content.

Extend Desktop
Extend Desktop treats both connected displays as separate devices, and they act as a virtual desktop resulting in a large workspace. When enabled, you can drag any icons or windows across to the other display desktop. It is therefore possible to have one program visible in one of the displays, and a different program visible in the other display.

SLI Configuration & Multiple Displays
Note that if SLI configuration is enabled only a Single display may be used as the display device.

DO NOT use the Fn + F7 key combination to toggle through display options when SLI is enabled. SLI supports only a Single display, and attempting to configure dual displays may cause an error. Use the NVIDIA control panel to select the display to be used.
Configuring an External Display using the NVIDIA Control Panel

You can use the NVIDIA control panel to configure any attached displays.

1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. Go to NVIDIA Control Panel (see page B - 2).
3. Double-click Display (if the sub-menus are not visible), and then click Set up multiple displays.
4. Any attached display will appear under “1.Select the displays you want to use.”
5. Click the tickbox alongside any display you wish to use.
6. Click Apply > Yes to save any changes made.

Display Not Shown

If the attached display does not appear in the “1.Select the displays you want to use.” window, click “My Display is not shown...” and then click the appropriate button to force detection of the missing display.
Duplicating the Displays
1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. Go to NVIDIA Control Panel (see page B - 2).
3. Double-click Display (if the sub-menus are not visible), and then click Set up multiple displays.
4. Any attached display will appear under “1. Select the displays you want to use.”
5. Click the tickbox alongside any display you wish to use.
6. Right-click one of the display icons and click “Duplicate displays....” (select which is to be the primary display) to duplicate the desktop on both displays.

7. Click Apply > Yes to save any changes.
Extending the Display
1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. Go to NVIDIA Control Panel (see page B - 2).
3. Double-click Display (if the sub-menus are not visible), and then click Set up multiple displays.
4. Click to select a primary display under “1.Select the displays you want to use.”
5. Right-click one of the display icons and click “Extend Desktop on this display....” to extend the desktop across both displays.

6. Click Apply > Yes to save any changes.
Changing the Primary Display on Extended Displays

1. If you want to switch the primary display if the displays are extended then right-click the secondary display icon.
2. Select Make this the Windows primary display.
3. Click Apply > Yes to save the change.

Figure B - 7
Switch Primary Display

Right-click to select the secondary display and select Make this the Windows primary display.
Attaching Other Displays (Win 7)

Configuring an External Display in Windows 7
1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. Go to the **Screen resolution** control panel.
3. Click the **Detect** button.
4. The computer will then detect any attached displays.

**Function Key Combination**
You can use the **Fn + F7** key combination to toggle through the display options:
- Notebook Only
- External Display Only
- Notebook + External Display

Make sure you give the displays enough time to refresh.

**DO NOT** use the **Fn + F7** key combination to toggle through display options when SLI is enabled.

*Figure B - 8*
**Screen Resolution**
Multiple Displays (Win 7)
5. You can configure the displays from the **Multiple Displays** menu.

- **Duplicate these displays** - Shows an exact copy of the main display desktop on the other display(s)
- **Extend these displays** - Treats both connected displays as **separate** devices
- **Show desktop only on 1/2** - Only one of your displays is used.

---

**B - 12 Attaching Other Displays (Win 7)**

*Figure B - 9*

**Screen Resolution Multiple Display Options (Win 7)**
Using the Windows Logo Key + P Key Combination to Switch Displays
You can also use the + P key combination to quickly change display configuration and modes (this is particularly useful when attaching a projector) in Windows 7.

1. Attach your external display to the external monitor port and turn it on.
2. Press the + P key combination.
3. An on-screen menu will pop up.
4. Use the cursor keys (or + P) to select the appropriate configuration from the menu, and press Enter to confirm the selection.

Figure B - 10
+ P Display Configuration Selection (Win 7)
SLI Multi GPU Configuration

This computer features an NVIDIA Scalable Link Interface (SLI) that improves graphic quality and performance by combining dual NVIDIA GPUs (two video cards are required) in a single system. To enable/disable SLI Configuration:

1. Go to NVIDIA Control Panel (see page B - 2).
2. Click “+” next to 3D Settings if its sub-items are not shown and then click Set SLI and PhysX configuration.
3. Click “Enable SLI technology (recommended)” under “2.Select an SLI configuration:”.
4. Click to “Select the SLI focus display:” (only a single display may be used).
5. Click Apply and Yes to restart the computer (see over).

Figure B - 11
Set SLI Configuration

SLI Configuration & Multiple Displays

Note that if SLI configuration is enabled only a Single display may be used as the display device.

DO NOT use the Fn + F7 key combination to toggle through display options when SLI is enabled. SLI supports only a Single display, and attempting to configure dual displays may cause an error. Use the NVIDIA control panel to select the display to be used.
SLI Multi GPU Configuration & Battery Power

Note that due to the high power and system demands created by enabling SLI Configuration, **you should not enable SLI configuration if your computer is powered by battery only.** If you attempt to run an SLI configuration when the computer is powered by the battery only, then system problems may occur.

- If the computer is currently powered by battery only **do not enable SLI configuration.**

- If you have currently enabled SLI configuration, and the computer is powered by the AC/DC adapter, **do not switch to battery power only** (or go to the NVIDIA Control Panel and disable SLI configuration before switching to battery power only).
Enabling TV Display

To display desktop images on a TV, connect the TV to your computer by using an HDMI cable/DVI cable from the TV to the HDMI-Out port/DVI-Out port (if supported by your TV).

You will need to enable the TV display from the NVIDIA Control Panel as per the instructions on B - 7. The TV will appear as a display option (1. Select the displays you would like to use.) when attached to the appropriate port. Apply the settings, and then click Yes to save the changes.

Detect Displays
To get a full range of display options click “My display is not shown in the list...”.

HDMI Audio Setup
See “HDMI Audio Configuration” on page 2 - 13 for instructions on configuring audio for HDMI display devices.

Set up your external display (TV or LCD) for HDMI input (see your display device manual).

Figure B - 12
Set Up Multiple Displays
(with TV connected)
Changing the TV Signal Format

1. When the TV is enabled as a display device click the sub-menus under Video & Television.
2. Click “Change the signal or HD format”.
3. Select the connector or format you want to use (the menu that appears will depend upon your type of connector).
4. Apply the settings, and then click Yes to save the changes.

Figure B - 13
Change the Signal or HD Format
The NVIDIA Control Panel provides additional configuration controls to adjust the TV settings in the Video & Television menu.

Figure B - 14
NVIDIA Control Panels (Video & Television)
Appendix C: Specifications

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer’s release schedule. Check with your service center for details.
## Specifications

<table>
<thead>
<tr>
<th>Processor</th>
<th>Display</th>
<th>BIOS</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Intel® Core i7-720QM Processor:</strong> 1.6GHz</td>
<td>18.4&quot; HD+/ FHD (1920 * 1080) TFT LCD</td>
<td>One 32Mb Flash ROM Phoenix™ BIOS</td>
</tr>
<tr>
<td>45nm (45 Nanometer) Process Technology, 6M L3 Cache &amp; FSB 1333MHz - TDP 45W rPGA988A Package</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Intel® Core i7-820QM Processor:</strong> 1.73GHz</td>
<td></td>
<td></td>
</tr>
<tr>
<td>45nm (45 Nanometer) Process Technology, 8M L3 Cache &amp; FSB 1333MHz - TDP 45W rPGA988A Package</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Intel® Core i7-920XM Processor:</strong> 2.00GHz</td>
<td></td>
<td></td>
</tr>
<tr>
<td>45nm (45 Nanometer) Process Technology, 8M L3 Cache &amp; FSB 1333MHz - TDP 55W rPGA988A Package</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Core Logic</td>
<td>Memory</td>
<td>Storage</td>
</tr>
<tr>
<td>Intel® PM55 Chipset</td>
<td><strong>DDRIII (DDR3) Dual Channels</strong></td>
<td>Up to three (Factory Option)</td>
</tr>
<tr>
<td></td>
<td>Two 204 Pin SO-DIMM Sockets</td>
<td>Changeable 2.5&quot; 9.5 mm (h) SATA</td>
</tr>
<tr>
<td></td>
<td>Supporting <strong>DDRIII (DDR3) 1066MHz/1333MHz</strong> Memory Modules</td>
<td>(Serial) Hard Disk Drives supporting RAID level 0/1</td>
</tr>
<tr>
<td></td>
<td>Memory Expandable up to 8GB</td>
<td>One 12.7 mm Super Multi/Blu-Ray</td>
</tr>
<tr>
<td></td>
<td>Compatible with 2GB or 4GB Modules</td>
<td>Combo/Blu-Ray Writer SATA Optical</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Device Drive (Factory Option)</td>
</tr>
<tr>
<td></td>
<td><strong>Video Adapter Options</strong></td>
<td>Audio</td>
</tr>
<tr>
<td>nVIDIA® GeForce GTX 280M SLI PCIe Video Card</td>
<td>High Definition Audio</td>
<td>3D Enhanced Sound System</td>
</tr>
<tr>
<td>1GB GDDR3 Video RAM On Board</td>
<td>S/PDIF Digital Output</td>
<td></td>
</tr>
<tr>
<td>Supports PCIe * 8 (SLI - 2 * PCIe * 8)</td>
<td>Built-In Microphone</td>
<td></td>
</tr>
<tr>
<td>Supports Microsoft DirectX® 10.0</td>
<td>5.1 Channel Speakers (with Subwoofer)</td>
<td></td>
</tr>
<tr>
<td>Supports HDCP</td>
<td>Dolby Home Theater Certified</td>
<td></td>
</tr>
<tr>
<td>nVIDIA® GeForce GTX 285M SLI PCIe Video Card</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1GB GDDR3 Video RAM On Board</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Supports PCIe * 8 (SLI - 2 * PCIe * 8)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Supports Microsoft DirectX® 11.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Supports HDCP</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**C - 2 Specifications**
### Specifications

<table>
<thead>
<tr>
<th><strong>Keyboard &amp; Pointing Device</strong></th>
<th><strong>Interface</strong></th>
<th><strong>Communication</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Full Size Winkey Keyboard with Numeric Keypad</td>
<td>Four USB 2.0 Ports</td>
<td>Built-In 10/100/100 Base-TX Ethernet LAN</td>
</tr>
<tr>
<td>Built-In TouchPad (with Multi Gesture Functionality)</td>
<td>One eSATA Port</td>
<td>Bluetooth 2.1 + EDR (Enhanced Data Rate) Module (Factory Option)</td>
</tr>
<tr>
<td>Eight Touch Sensor Instant Keys (Color, CCD, Bluetooth, WLAN, Internet, Silent Mode, Sound Effect, Mute)</td>
<td>One Mini-IEEE1394a Port</td>
<td>Intel® WiFi Link 5300 Series (3*3 - 802.11a/g/n) Wireless LAN PCIe Interface Half Mini-Card Module (Factory Option)</td>
</tr>
<tr>
<td>Eight Gaming Keys G1 ~ G8</td>
<td>One DVI-Out Port (with CRT out)</td>
<td>3rd Party 802.11b/g/n Wireless LAN PCIe Interface Half Mini-Card Module (Factory Option)</td>
</tr>
<tr>
<td><strong>Card Reader</strong></td>
<td>One HDMI-Out Port (High-Definition Multimedia Interface) Port (with HDCP Support)</td>
<td>2.0M Pixel PC Video Camera Module (Factory Option)</td>
</tr>
<tr>
<td>Embedded 7-in-1 Card Reader (MS/ MS Pro/ SD/ Mini SD/ MMC/ RS MMC/ MS Duo) <strong>Note:</strong> MS Duo/ Mini SD/ RS MMC Cards require a PC adapter</td>
<td>One HDMI-In (High-Definition Multimedia Interface) Port (with HDCP Support)</td>
<td>Mini-Card TV Tuner Module (Factory Option)</td>
</tr>
<tr>
<td><strong>Slots</strong></td>
<td>One RJ-45 LAN Jack</td>
<td><strong>Security</strong></td>
</tr>
<tr>
<td>One ExpressCard/34 Slot</td>
<td>One Headphone/Speaker-Out Jack</td>
<td>Security (Kensington® Type) Lock Slot</td>
</tr>
<tr>
<td>Two Mini Card Slots:</td>
<td>One Microphone-In Jack</td>
<td>BIOS Password</td>
</tr>
<tr>
<td>Slot 1 for PCIe WLAN Module</td>
<td>One Line-In Jack</td>
<td>Fingerprint Reader Module (Factory Option)</td>
</tr>
<tr>
<td>Slot 2 for PCIe TV Tuner Module</td>
<td>One S/PDIF Out Jack</td>
<td></td>
</tr>
<tr>
<td>One DC-In Jack</td>
<td>One Consumer Infrared Port for TV Tuner Remote Controller</td>
<td></td>
</tr>
<tr>
<td>One CATV-In Jack (for TV Tuner)</td>
<td><strong>Communication</strong></td>
<td></td>
</tr>
</tbody>
</table>
## Specifications

<table>
<thead>
<tr>
<th>Operating System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows® 7</td>
</tr>
<tr>
<td>Note that the TV Tuner module (factory) option in is supported by the <strong>Windows Media Center</strong> software. <strong>Windows Media Center</strong> is not included in <strong>Starter</strong> or <strong>Home Basic</strong> versions of <strong>Windows 7</strong>.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Power Management</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supports Wake on LAN</td>
</tr>
<tr>
<td>Supports Wake on USB</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Power</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full Range AC/DC Adapter – AC in 100 - 240V, 50 - 60Hz DC Output 19V, 11.57A (220 Watts)</td>
</tr>
<tr>
<td>Removable Polymer Smart Lithium-Ion 68.82Wh Main Battery</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Environmental Spec</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature</td>
</tr>
<tr>
<td>Operating: 5°C - 35°C</td>
</tr>
<tr>
<td>Non-Operating: -20°C - 60°C</td>
</tr>
<tr>
<td>Relative Humidity</td>
</tr>
<tr>
<td>Operating: 20% - 80%</td>
</tr>
<tr>
<td>Non-Operating: 10% - 90%</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Physical Dimensions &amp; Weight</th>
</tr>
</thead>
<tbody>
<tr>
<td>439mm (w) * 299mm (d) * 44mm (h)</td>
</tr>
<tr>
<td>Around 5.6kg with Battery and ODD</td>
</tr>
</tbody>
</table>

C - 4 Specifications